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REFERENCES

CONVENTIONS

This manual uses the following conventions:

"User" refers to anyone using a Matrix 300™ reader.
"Reader" refers to the Matrix 300™ reader.

"You" refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a Matrix 300™ reader.

REFERENCE DOCUMENTATION
For further details refer to: the VisiSet™ Help On Line, Matrix Reading Methods, Matrix Host

Mode Programming, Matrix SW Parameter Guide, Matrix Code Quality Verifier Solution
provided as supplementary documentation on Mini-DVD.

SUPPORT THROUGH THE WEBSITE

Datalogic provides several services as well as technical support through its website. Log on
to www.datalogic.com and click on the Industrial Automation links for further information:

e Products - Industrial Automation - Identification

Select your product from the links on the Identification page. The product page
describes specific Info, Features, Applications, Models, Accessories, and Downloads
including documentation, software drivers, and the VisiSet™ utility program, which allows
device configuration using a PC through Serial and Ethernet interfaces.

e Support & Services - Industrial Automation

Several links from the Industrial Automation list take you to additional services such as:
Service Program which contains Maintenance Agreements and Warranty Extensions;
Repair Centers; On-Line RMA Return Material Authorizations; Technical Support through
email or phone, Partner Program; Downloads for additional downloads.

PATENTS

This product is covered by one or more of the following patents:

Utility patents: US6,512,218 B1; US6,616,039 B1; US6,808,114 B1; US6,997,385 B2,
US7,053,954 B1, US7,387,246 B2; USS8,058,600 B2; EP996,284 B1; EP999,514 B1,;
EP1,014,292 B1; EP1,128,315B1; EP1,396,811 B1; EP1,413,971 B1, JP4,435,343 B2,
JP4,571,258 B2.

Additional patents pending.

Vi



COMPLIANCE

For installation, use and maintenance it is not necessary to open the reader.

Only connect Ethernet and dataport connections to a network which has routing only within the plant
or building and no routing outside the plant or building.

EMC COMPLIANCE

In order to meet the EMC requirements:

e connect reader chassis to the plant earth ground by means of a flat copper braid shorter than
100 mm,;

e connect pin "Earth" of the CBX connection box to a good Earth Ground;
o for direct connections, connect your cable shield to the locking ring nut of the connector

POWER SUPPLY
ATTENTION: READ THIS INFORMATION BEFORE INSTALLING THE PRODUCT

This product is intended to be installed by Qualified Personnel only.

This product is intended to be connected to a UL Listed Computer (LPS or “Class 2”) which supplies
power directly to the reader, or a UL Listed Direct Plug-in Power Unit (rated 10 to 30 V, minimum 1 A)
marked LPS or “Class 2", or Power over Ethernet source Device supplied by UL Listed Direct Plug-in
Power Unit marked LPS or “Class 2.

CE COMPLIANCE

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

FCC COMPLIANCE

Modifications or changes to this equipment without the expressed written approval of Datalogic could
void the authority to use the equipment.

This device complies with PART 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference which may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

vii



LASER SAFETY

The Matrix 300™ internal illuminators contain two aiming Laser LEDs used to position the
reader.

This product conforms to the applicable requirements of IEC 60825-1 and complies with 21
CFR 1040.10 except for deviations pursuant to Laser Notice N° 50, date June 24, 2007. This
product is classified as a Class 2 laser product according to IEC 60825-1 regulations.

CAUTION: Use of controls or adjustments or performance of procedures
other than those specified herein may result in exposure to hazardous visible
laser light.

Disconnect the power supply when opening the device during maintenance or installation to
avoid exposure to hazardous laser light. The laser beam can be switched on or off through a
software command.

Sh e q3
S1Cadi°' ON2468

This product is covered by one or more of the following US pat.:
US6,512,218 B1; US6,616,039 B1; US6,808,114 B1;
US6,997,385 B2; US7,053,954 B1; US7,387,246 B2;

US8,058,600 B2.
See product manual and package for complete patent listing.

LASER LIGHT - DO NOT STARE INTO BEAM
CLASS 2 LASER PRODUCT
MAX OUTPUT RADIATION 1 mW
EMITTED WAVE LENGHT 630 — 680 nm
1EC 60825-1: 2007

Complies with 21 CFR 1040. 10
except for deviations pursuant
to Laser Notice N°50.
date June 24, 2007

DATALOGIC Automation S.r.L
Via Lavino, 265 - 40050 Monte San Pietro (BO) taly

voww datalogic.com

g .y

AVOID EXPOSURE LASER LIGHT
IS EMITTED FROM THIS APERTURE

LED SAFETY

LED emission according to EN 62471.
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HANDLING

The Matrix 300™ is designed to be used in an industrial environment and is built to withstand
vibration and shock when correctly installed, however it is also a precision product and
therefore before and during installation it must be handled correctly to avoid damage.

¢ avoid that the readers are dropped (exceeding shock limits).

¢ do not fine tune the positioning by striking the reader or bracket.




e do not weld the reader into position which can cause electrostatic, heat or reading window
damage.

e do not spray paint near the reader which can cause reading window damage.

NO

&

™
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GENERAL VIEW

Matrix 300™
Liquid Lens Models

s
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US6,512,218 B1; US6,616,039 B1; US6,808,114 B1; |
US6,997,385 B2; US7,053,954 B1; US7,387,246 B2; |

US8,058,600 B2

See product manual and package for complete patent listing
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o date June 24, 2007 L
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Connector block
rotates to 90° position

Figure A

@ Device Class and Warning Labels Power - Serial Interfaces - I/O Connector
@ Bracket Mounting Holes (4) @ Ethernet Connector

@ Good Read LED (green) No Read LED (red)

@ Lens Cover @ Aiming System Laser Pointers

@ HMI X-PRESS™ Interface @ Ethernet Connection LED

@ Lens @ Power On LED
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Matrix 300™

Fixed Lens Models
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Figure B

Connector block
rotates to 90° position

@ Device Class and Warning Labels Internal llluminator

@ Bracket Mounting Holes (4) @ Power - Serial Interfaces - I/O Connector

@ Good Read LED (green) Ethernet Connector
@ Lens Cover @ No Read LED (red)

@ HMI X-PRESS™ Interface @ Aiming System Laser Pointers

@ Lens @ Ethernet Connection LED
@ Focus Adjustment Screw Power On LED
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RAPID CONFIGURATION o

1 RAPID CONFIGURATION

STEP 1 - CONNECT THE SYSTEM

To connect the system in a Stand Alone configuration, you need the hardware indicated in
Figure 1. In this layout the data is transmitted to the Host on the main serial interface. Data
can also be transmitted on the RS232 auxiliary interface independently from the main
interface selection.

When One Shot or Phase Mode Operating mode is used, the reader is activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

PG-6000 Host
|
|
CAB-DSxx @ i = |
| © | =
cBX | <
Matrix 300™ | ML AR
j I @® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
| @ External Trigger (for One Shot or Phase Mode)

[ ] @ 110, Aux

Figure 1 — Matrix 300™ in Stand Alone Layout




o MATRIX 300™ REFERENCE MANUAL

CBX100/CBX500 Pinout for Matrix 300™

The table below gives the pinout of the CBX100/CBX500 terminal block connectors. Use this
pinout when the Matrix 300™ reader is connected by means of the CBX100/CBX500:

CBX100/500 Terminal Block Connectors

Input Power Outputs
Vdc Power Supply Input Voltage + +V Power Source - Outputs
GND | Power Supply Input Voltage - -V Power Reference - Outputs
Earth | Protection Earth Ground Ol+ Output 1 +
O1- Output 1 -
Inputs 02+ Output 2 +
+V Power Source — External Trigger 02- Output 2 -

I1A External Trigger A (polarity insensitive)
1B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger

O3A Output 3 (CBX500 only)

+V Power Source — Inputs Auxiliary Interface
I2A Input 2 A (polarity insensitive) TX Auxiliary Interface TX
2B Input 2 B (polarity insensitive) RX Auxiliary Interface RX
-V Power Reference — Inputs SGND | Auxiliary Interface Reference
Shield ID-NET™
Shield | Network Cable Shield REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -

Main Interface

RS232 RS485/422 Full-Duplex
X TX+
RTS TX-
RX *RX+
CTS *RX-
SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.

ground references. GND, SGND and REF are internally connected through
filtering circuitry which can be permanently damaged if subjected to voltage
drops over 0.8 Vdc.

i CAUTION: Do not connect GND, SGND and REF to different (external)




RAPID CONFIGURATION o

STEP 2 — MOUNT AND POSITION THE READER

1. To mount the Matrix 300™, use the mounting brackets to obtain the most suitable
position for the reader. The most common mounting configuration is shown in the figure
below.

—
J
S
S
<
n
9

SOATALOGIC

Figure 2 —Positioning with Mounting Bracket

2. When mounting the Matrix 300™ take into consideration these three ideal label position
angles: Pitch or Skew 10° to 20° and Tilt 0°, although the reader can read a code at any tilt
angle provided the code fits into the Field Of View (FOV).

Tilt Skew
any angle
inside FOV

Assure at least 10°

Pitch

Minimize

No Pitch, Tilt or Skew

FOVy

FOVy \I\KIIIIIIIIIIIIIII

Figure 3 — Pitch, Tilt and Skew Angles

3. Refer to the reading diagrams in chp. 6 to determine the distance your reader should be
positioned at.

NOTE: Rapid Configuration of the Matrix 300™ reader can be made either
through the X-PRESS™ interface (steps 3-4) which requires no PC
connection, or by using the VisiSet™ Setup Wizard (steps 5-6). Select the
procedure according to your needs.




MATRIX 300™ REFERENCE MANUAL

STEP 3 - AIM AND AUTOFOCUS THE READER

(Liquid Lens Models only)
Matrix 300™ provides a built-in laser pointer aiming system to aid reader positioning. For

Liquid Lens models the autofocus feature is also incorporated into this function. The aiming
system is accessed through the X-PRESS™ Interface.

1. Power the reader on. During the reader startup (reset or restart phase), all the LEDs blink
for one second. On the reverse side of the reader near the bracket, the “POWER ON”

LED (blue) indicates the reader is correctly powered.

2. Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance for your application. See the Reading Diagrams in chapter 6 for reference.

Enter the Aim/Autofocus function by pressing and holding the X-PRESS™ push button

until the Aim LED is on.
4. Release the button to enter the Aim function. The laser pointers turn on, and the
Autofocus procedure begins, see Figure 4. The Aim LED will blink until the procedure is

completed.
Within 3 seconds (before the reader flashes), center one of the larger codes on the

aiming system pointers (the code must not move during this procedure).

The Autofocus procedure ends when the Reading Distance and PPl values are
successfully saved in the reader memory, the Aim LED will stop blinking and Matrix 300™

emits 3 high pitched beeps.
If the Autofocus cannot be reached after a timeout of about 3 (three) minutes Matrix 300™
will exit without saving the parameters to memory, the Aim LED will stop blinking and in this

case Matrix 300™ emits a long low pitched beep.

TEST AIM SETUP LEARN

O ®© ® @ @

STATUS COM TRIGGER GOOD READY

&

o
Q
3
<
A
¢
<

BARCODE TEST capy . GRADE

Figure 4 — X-PRESS™ Interface: Aim/Autofocus Function

NOTE: You can exit the Aim/Autofocus function at any time by pressing the
X-PRESS™ push button once. After a short delay the autofocus procedure is
cancelled and the laser pointers turn off.
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(Fixed Lens Models only)

The Matrix 300™ fixed lens models are factory focused to a precise Reading Distance. If this
distance is compatible with your application you can use the X-PRESS™ Interface to install
the reader, if not, use the VisiSet™ procedure described in step 6B.

1. Place the reader at the factory focused Reading Distance and go to step 4.

Factory focus for 6 mm fixed lens models is 85 mm.

STEP 4 — X-PRESS™ CONFIGURATION

Once Matrix 300™ has focused at the correct reading distance, you must configure it for
optimal code reading relative to your application. This configuration can be performed either
through the X-PRESS™ Interface or the VisiSet™ configuration program.

Aim

1. Enter the Aim function by pressing and holding the
X-PRESS™ push button until the Aim LED is on.

2. Release the button to enter the Aim function. The

laser pointers turn on. TEST AM SETUP LEARN
: L C & & & 0
3. Select a single code from your application. STATUS COM TRIGGER GOOD READY

Position the code at the center of the FOV
(equidistant from the laser pointers). @
For Liquid Lens models the reader may start flashing and try

to perform autofocus however this will have no effect on the
application specific code; it can be ignored.

Figure 5 — X-PRESS™ Interface: Aim
Exit the Aim function by pressing the X-PRESS™ Function

push button once. After a short delay the Aim

function is cancelled and the laser pointers turn

off.

Setup

4. Enter the Setup function by pressing and holding
the X-PRESS™ push button until the Setup LED is

on.
5. Release the button to enter the Setup function.

The Setup LED will blink until the procedure is TEST AM SETUP LEARN

completed. O ®@ ® O @

STATUS COM TRIGGER GOOD READY

The Setup procedure ends when the Image

Acquisition parameters are successfully saved in

the reader memory, the Setup LED will stop

blinking and Matrix 300™ emits 3 high pitched
beeps.

Figure 6 — X-PRESS™ Interface: Setup
If the calibration cannot be reached after a timeout Function

of about 5 (five) seconds Matrix 300™ will exit

without saving the parameters to memory, the

Setup LED will stop blinking and in this case Matrix

300™ emits a long low pitched beep.
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Learn

®© © G

6. Enter the Learn function by pressing and holding

the X-PRESS™ push button until the Learn LED is
on.

. Release the button to enter the Learn function.

The Learn LED will blink until the procedure is
completed.

The Learn procedure ends when the Image
Processing and Decoding parameters are
successfully saved in the reader memory, the
Green Spot is activated, the Learn LED will stop
blinking and Matrix 300™ emits 3 high pitched
beeps'.

If the autolearning cannot be reached after a
timeout of about 3 (three) minutes Matrix 300™ will
exit without saving the parameters to memory, the
Learn LED will stop blinking and in this case Matrix
300™ emits a long low pitched beep.

cancelled.

7.

Reset Reader to Factory Default (Optional)

TEST AIM SETUP LEARN

O @ ® O O

STATUS COM TRIGGER GOOD READY

Figure 7 — X-PRESS™ Interface: Learn
Function

NOTE: The Grade A Barcode Test Chart cannot be used to set the Code
128 symbology (even though the reader successfully reads the code). Use
the application specific code if you need to set this symbology.

NOTE: You can exit the Learn function at any time by pressing the X-
PRESS™ push button once. After a short delay the Learn procedure is

NOTE: If you have used this procedure to configure Matrix 300™ go to step

If it ever becomes necessary to reset the reader to the factory default values, you can
perform this procedure by holding the X-PRESS™ push button pressed while powering up
the reader. You must keep the X-PRESS™ push button pressed until the power up
sequence is completed (several seconds) and all LEDs blink simultaneously 3 times.

All LEDs remain on for about 1 second, then off for one second, the Configuration and
Environmental parameters are reset, and the status LED remains on. If connected through a
CBX500 with display module, the message "Default Set" is shown on the display.

! The Learn procedure will not recognize Pharmacode symbologies.

6
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STEP 5 — INSTALLING VISISET™ CONFIGURATION PROGRAM

VisiSet™ is a Datalogic reader configuration tool providing several important advantages:

e Setup Wizard for rapid configuration and new users;

¢ Defined configuration directly stored in the reader;

e Communication protocol independent from the physical interface allowing the reader to
be considered as a remote object to be configured and monitored.

To install VisiSet™, turn on the PC that will be used for the configuration, running
Windows 98, 2000/NT, XP, Vista, 7 or 8; then insert the VisiSet™ Mini-DVD, wait for it to
autorun and follow the installation procedure.

This configuration procedure assumes a laptop computer, running VisiSet™, is connected to
the reader's auxiliary port. The reader can also be connected to VisiSet™ through the on-
board Ethernet by following the procedure in chp. 7.

After installing and running the VisiSet™ software program the following window:

File Edit Connect Disconnect Device Options Tools Help

Press <Connect> to configure the reader.|

Figure 8 - VisiSet™ Opening Window

Set the communication parameters from the "Options" menu. Then select "Connect”, the
following window appears:

EBX

File Edt Connect Disconnect Device Options Tools Help

MAIN MENU
Device: Matrix 300

.| M. Setup Wizard Model: 412-010
Communication Port: Ethernet
F. Calibration Tool

Standard Application Program for Matrix Family Rel. 6.60

1. Data Matrix Setup Wizard MACHUM: 00:07:BE:00:99:A2
DHCP disabled.

A. Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0

B. Capture Image Gateway: 172.27.2.254
DNS1: 172.27.0.32

C. Decode Last Image

D. View Last Image

E. Download Last Image

H. Upload Bitmap Image

G. Store Match Code

Q. Image Buffer

3. Button Function Menu

Connection: B13P00018 on 172.27.101.151 Reader Status: OFF LINE MODE Log : OFF

Figure 9 - VisiSet™ Main Window After Connection
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STEP 6A — USING SETUP WIZARD FOR LIQUID LENS MODELS

NOTE: For Fixed Lens models go to Step 6B.

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader
configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

M Setup Wizard Q\E“Y\ ] Setup Wizard E]@H;

Top.Left
1. Positioning Send Defaults
Calibration Mode

o @ Change Expostre Time And Gain (Static Mods]
" Change Gain Only

Fine Focusing
Code Setting Mode

Capture Image
3. Code Setting & Add New Symbology
" Replace Current Symbologies
Bottom, Right 4‘ Saving Options

Image &cquisition Information ~ Pemanent Memory
Acquisition Setting: 4|

* Temporary Memory

Setup Result

Decoding Results |

Symbology: Selected Code: h j]
Code Data:
Code Center:

Image Lighting Quality

TX/RX

J Close

2. Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance for your application. See STEP 2 - Mount and Position the Reader and the
Reading Diagrams in chapter 6 for reference.

3. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. The Setup Wizard now shows four delimiters (red
points) in the acquired images which indicate the region in which the calibration algorithm
is active. Choose one of the larger codes and move either the reader or code to center it.
The code must be aligned across the X-axis reference line at the center of the FOV. See
figure below.

Press the Positioning button again to stop positioning.
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E Setup Wizard
Top.Left

Acquisition Setting:
Exposure Time (xTus):
Gain:

Decoding Results
Symbology:

Code Data:

Code Center:

Image Lighting Quality

Capture Image
View Image
Download Image
Bottom, Right

Disabled

Image Acquisition Information

1 Self Tuning:
279 Read. Dist. (x1mm}): 302

‘ t

The Read. Dist. value is
not significant until the
Autofocus procedure ends
successfully.

s

TX/RX

_J Close

< Bﬂ Setup Wizard

_ dsae |

Setup Result

‘ i Code Setting Mode

Calibration Mode
@ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

& Add New Symbology
" Replace Current Symbologies

Saving Options
" Permanent Memory
@ Temporary Memory

4. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings.

'

Top.Left

Image &cquisition Information
Acquisition Setting:

Exposure Time (xTus):

Gain:

Decoding Results
Symbology:

Code Data:

Code Center:

Image Lighting Quality

1
273
1

Capture Image
View Image
Download Image
Bottom,Right

Self Tuning: Enabled
Read. Dist. (x1mm): 302 Status: Completed
Selected Code: h ﬂ
TX/RX

_J Close

Positioning

) Calibration Mode-

Send Defaults

& Change Exposure Time And Gain (Static Mode)

" Change Gain Only

5 Fine Focusing

Code Setting Mode

3. Code Setling @ Add New Symbology
" Replace Current Symbologies
Saving Options:

4. Save " Permanent Memory
& Temporary Memory

Setup Result

Calibration procedure in progress ...

Calibration procedure completed using Image Acquisition
Setting #1.
New Exposure Time (xlus):

279
New Gain ¢ 11

5. Press the "Fine Focusing" button to activate the Focus procedure.

CAUTION: For Liquid Lens models, the Fine Focusing procedure requires

the Grade A Barcode Test Chart to be used; otherwise the procedure will
fail.

A\
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EB Confirmation @ Setup Result

AutoFocusing Progress: 0% N
iAutoFocusing Progress: 25%
' ' lAutoFocusing Progress: 37%
This step requires the Grade A Barcode Test RS i

Chartto be used. AutoFocusing Progress: 61% O K

o . o AutoFocusing Progress: 73%
The optimal focus will automatically be AutoFocusing Progress: 74%
determined and setin Acquisition Setting #1. ArReReGieng REoESR I

AutoFocusing Progress: 100%

. New Reading Distance (xlmm): 188
Do you want to continue? New Inage Density (PPI): 222
Field Of View = 146 mm x 117 mml

X No
Setup Result
) AutoFocusing Progress: 25? ~
The reader starts the focus procedure and gives | [umoss posees: o0
visual feedback in the Setup Wizard window. The | [crses moees: 7 KO
lAutoFocusing Progress: 74%

Setup Result section of the Setup Wizard window | |awcerocusing rrogress: 75

reports the procedure progress (|n percentage)_ L R e

lAutoFocusing Progress: 100%.

Focus procedure failed ! Make sure you are using the

At the end Of the procedure the Readlng DiStance, Grade & Barcode Test Chart at a valid Reading Distance. -
PPl and FOV data are reported.

6. Now place a single application specific code in front of the reader (at the same reading
distance) and repeat steps 3, and 4. Do not perform step 5 "Fine Focusing".
7. Select a Code Setting Mode choice and press the "Code Setting" button.

The Setup Result section of the Setup Wizard window shows the code type results.

i) P SEL
Top.Left

|

3 Paositioning Send Defaults
| Calibration Mode

4

2. Calibration @ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

H

Fine§Focusing

Capture Image | Code Setting Mode
7 3. Code Seting | @ Add New Symbology
Download Image
Bottom Right Saving Options

" Replace Current Symbologies
Imagé A,qusmtfn l.niovmatlon } i 4 Save " Permanent Memory
Acquisition Setting: 1 Self Tuning Disabled @ Temporary Memory

Exposure Time (x1us): 143 Read. Dist. [x1mm): 188
Gain: 18 Setup Result
Decoding Results ) &
Symbology: Data Matiix ECC 200 Selected Code: T4 ROAF BCRRINT proceie N PEONEEaS n e
Code Data: 1293003393 Code Setting procedure completed: 1 code(s) found.
Code Center: (X.Y)=(565,473) Code Symbologies:
- B, 2 . 1. Data Matrix ECC 200
Code Orientation: 180 Quality Index: m Processing Mode : Low Height Codes Setu Result
iahtit i Rectangular Formats : Disabled p
Image Lighting Quality 2 . p
Data Matrix Module Size: 14 mils
Exposure Index: Lighting Indes: Code Color : Black
Underesposed ok Overesposed Inage Mirroring : Disabled
Code Contrast (2D) : Standard
TX/RX Decoding Method : Standard
‘[ Close | | ]

NOTE: The Grade A Barcode Test Chart cannot be used to set the Code
128 symbology (even though the reader successfully reads the code). Use
the application specific code if you need to set this symbology.

10
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8. Select a Saving Options choice and press the "Save" button.

&) Setup Wizard E]‘E X

Positioning Send Defaults
Calibration Mode:

2. Calibration @ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Fine Focusing

Code Setting Mode:

3. Code Setling & Add New Symbology

" Replace Current Symbologies

Saving Options

@+ Permanent Memory e

¢ Temporary Memory

Setup Result

Code Setting procedure completed: 1 code(s) found. -~
Code Symbologies:
1. Data Matrix ECC 200

Processing Mode : Low Height Codes
Rectangular Formats : Disabled

Data Matrix Module Size: 14 nils

Code Color : Black

Image Mirroring : Disabled

Code Contrast (2D) : Standard
Decoding Method : Standard

Checking configuration...OK
Configuration saved in Permanent memory!

9. Close the Setup Wizard.

NOTE: If your application has been configured using the VisiSet™ Setup

Wizard, your reader is ready. If necessary you can use VisiSet™ for
advanced reader configuration.

11
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STEP 6B — USING SETUP WIZARD FOR FIXED LENS MODELS

NOTE: For Liquid Lens models go to Step 6A.

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader
configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

M Setup Wizard Q\E“Y\ ] Setup Wizard E]@H;

Top.Left
1. Positioning Send Defaults
Calibration Mode

o @ Change Expostre Time And Gain (Static Mods]
" Change Gain Only

Fine Focusing
Code Setting Mode

Capture Image
3. Code Setting & Add New Symbology
" Replace Current Symbologies
Bottom, Right 4‘ Saving Options

Image &cquisition Information ~ Pemanent Memory
Acquisition Setting: 4|

* Temporary Memory

Setup Result

Decoding Results |

Symbology: Selected Code: h j]
Code Data:
Code Center:

Image Lighting Quality

TX/RX

J Close

2. Place the Grade A Barcode Test Chart in front of the reader at the correct reading
distance for your application. See STEP 2 - Mount and Position the Reader and the
Reading Diagrams in chapter 6 for reference.

3. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. The Setup Wizard now shows four delimiters (red
points) in the acquired images which indicate the region in which the calibration algorithm
is active. Choose one of the larger codes and move either the reader or code to center it.
The code must be aligned across the X-axis reference line at the center of the FOV. See
figure below.

Press the Positioning button again to stop positioning.

12
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Eﬁ Setup Wizard
Top.Left

s

Image Acquisition Information
Acquisition Setting:
Exposure Time (x1us):
Gain:

~Decoding Results
Symbology:
Code Data:
Code Center:

Image Lighting Quality

i
———HHE- - -
111

0.33(mm

0.28mm

1

it

sIII | III Capture Image
di View Image
= Download Image
Bottom,Right

Self Tuning: Disabled

Selected Code: h ﬂ

TR/RX

J Close

@ Setup Wizard

Calibration Mode
@ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Code Setting Mode

de & & Add New Symbology
" Replace Current Symbologies
~Saving Options

" Permanent Memory
@ Temporary Memory

Setup Result

4. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings.

E Setup Wizard
Top.Left

Image Acquisition Information
Acquisition Setting:
Exposure Time (xTus):

Gain:

Decoding Results
Symbology:

Code Data:

Code Center:

Image Lighting Quality

EE

Capture Image

View Image
Download Image
Bottom,Right
Self Tuning: Enabled
Status: Completed
Selected Code: (i il‘
TX/RX

_J Close

) —Calibration Mode-
@ Change Exposure Time And Gain (Static Mode)

: € Change Gain Only

5 Fine Focusing

Code Setting Mode
3. Code Setting & Add New Symbology
" Replace Current Symbologies
Saving Options
4. Save " Pemanent Memory

& Temporary Memory

Setup Result

Positioning Send Defaults

Calibration procedure in progress ...

Calibration procedure completed using Image Acquisition
Setting #1.

New Exposure Time (xlus): 54

New Gain H

5. Press the "Fine Focusing" button to activate the Focus procedure.
The reader continuously acquires images and gives visual feedback on the
quality in the Focusing Tool window.

focusing

13
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E Focusing Tool

EBEX

White (255)

Kl ]

il
Black (0)
Focus information
Current Focus Quality: -
Maximum Session Value
Maximum Grey Level {Light): 169
Minimum Grey Level (Dark): 0 Cursor Position: 640 Grey Value: 69
Stop Image Acquisition Line Scan Viewer
@ Disabled = -
¢ Enabled :2 z’ Zoom 11 Panoramic View

Close

Rotate the Focusing screw on the side of the reader. The Current Focus Quality Bar
(green) together with the vertical optimal focus line (green) increase together until the
optimal focus is reached; the vertical optimal focus line stops.

Continue rotating the Focusing screw a little farther; the Current Focus Quality Bar
decreases (red) see below.

E Focusing Tool

EIEX

White (255)

Kl ] I
Black (0)
Focus information
Maximum Session Value

Maximum Grey Level {Light): 174

Minimum Grey Level (Dark): 0 Cursor Position: 640 GreyValue: 34

Stop Image Acquisition Line Scan Viewer

@ Disabled - Ry
 Ensbled 1:2 ‘_:i Zoom 1:1 Panaramic View

Close

Rotate the Focusing screw in the opposite direction. The Current Focus Quality Bar
(green) increases towards the vertical optimal focus line (green) until the optimal focus is

reached; the Current Focus Quality Bar touches the vertical optimal focus line
(indicating the best focus).
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m Focusing Tool

il

Focus information

Current Focus Quality:

Maximum Grey Level {Light):
Minimum Grey Level (Dark):
Stop Image Acquisition

@ Disabled

" Enabled

White (255)

]

Black (0)

I

176

0 Cursor

Line Scan Viewer

[Wﬂ Zoom 1_1| Panaramic View

Close

Maximum Session Value

Position: 640 Grey Value: 29

Press the "Close" button to return to the Setup Wizard.

Press the "Code Setting" button. The Grade A Barcode Test Chart, allows image

density calibration to be performed so that Matrix 300™ will function correctly and to the
fullest extent of its capabilities.

The Setup Result section of the Setup Wizard window shows the code type results and
the image density calibration settings reporting PPl and FOV.

&) Setup Wizard
Top.Left

Image Acquisition Information

Image Lighting Quality

Und

Acquisition Setting: 1

Exposure Time [x1us): 54

Gain: 8

Decoding Results

Symbology: Code 128

Code Data: 0.50 mm

Code Center: (X.Y)=(638,515)
Code Orientation: 0

Exposure Index:

Bottom, Right

Self Tuning:

Selected Code:

Lighting Index:

OK

o

TXIRX

|

Capture Image

H setup Wizard Q\EHX

Positioning Send Defaults
Calibration Mode

2. Calibration @ Change Exposure Time And Gain (Static Mode)

" Change Gain Only

Fine Focusing

) 1 Code Setting Mode

" @ Add New Symbology
e | 6| 3. Code Setting

" Replace Current Symbologies

Download Image

Disabled

=

Close

Saving Options

4 Save " Permanent Memory

@ Temporary Memory

Setup Result

Code Setting procedure completed: 4 code(s) found.
Code Symbologies:
1. Code 128
2. Code 128
3. Code 128
4. Code 128
Processing Mode : Standard

Image Density calibration procedure completed:
Image Density (PPI) = 260
Field Of View = 125 mm x 100 mm

Grade A Barcode Test Chart cannot be used to set Code
128 symbology. Use application specific code.

15
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Now place a single application specific code in front of the reader (at the same reading
distance) and repeat steps 3, and 4. Do not perform step 5 "Fine Focusing".

Select a Code Setting Mode choice and press the "Code Setting" button.

The Setup Result section of the Setup Wizard window shows the code type results.

Eﬁ Setup Wizard

Eﬁ Setup Wizard

TopLeft

Acquisition Setting:
Exposure Time [x1us):
Gain:

becoding Results
Symbology:

Code Data:

Code Center:

Code Orientation:

Image Lighting Quality

Exposure Index:

~Image Acquisition Information

Data Matrix ECC 200
Datalogic India_1
(X.Y)=(636.510)
3

Undererposed g

Overexposed

Capture Image
View Image

—

3 Paositioning
4

2. Calibration

4

Send Defaults

-~ Calibration Mode-
@ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Fine§Focusing

—

8 3. Code Setting I

Code Setting Mode
@ Add New Symbology
" Replace Current Symbologies

Download Image
Bottom,Right

Saving Options
" Permanent Memory

4. Save

@ Temporary Memary

Setup Result

Code Setting procedure in progress ...

Code Setting procedure completed: 1 code(s) found.
Code Symbologies:
1. Data Matrix ECC 200

Self Tuning: Disabled
Selected Code: 1 ﬂ
Qualiy Index:
Lighting Index:

TX/RX

|

Close

Setup Result

Processing Mode : Standard
Rectangular Formats : Disabled
Decoding Performance : Robust

Code Color : Black

Inage Mirroring : Disabled
Code Contrast (2D) : Standard
Decoding Method : Standard

the application specific code if you need to set this symbology.

NOTE: The Grade A Barcode Test Chart cannot be used to set the Code
128 symbology (even though the reader successfully reads the code). Use
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9. Select a Saving Options choice and press the "Save" button.

&) Setup Wizard E]‘E X

Positioning Send Defaults
Calibration Mode:

2. Calibration @ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Fine Focusing

Code Setting Mode:

3. Code Setling & Add New Symbology

" Replace Current Symbologies

Saving Options

@+ Permanent Memory e

¢ Temporary Memory

Setup Result

Code Setting procedure completed: 1 code(s) found. -~
Code Symbologies:
1. Data Matrix ECC 200

Processing Mode : Standard
Rectangular Formats : Disabled
Decoding Performance : Robust

Code Color : Black

Image Mirroring : Disabled
Code Contrast (2D) : Standard
Decoding Method : Standard

Checking configuration...OK
Configuration saved in Permanent memory!

10. Close the Setup Wizard.

NOTE: If your application has been configured using the VisiSet™ Setup

Wizard, your reader is ready. If necessary you can use VisiSet™ for
advanced reader configuration.

17
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STEP 7 - TEST MODE

Use a code suitable to your application to test the reading performance of the system.

1.

3.

Enter the Test function by pressing and holding the X-PRESS™ push button until the
Test LED is on.

Release the button to enter the Test function.
Once entered, the Bar Graph on the five LEDs is activated and if the reader starts

reading codes the Bar-Graph shows the Good Read Rate. In case of no read condition,
only the STATUS LED is on and blinks.

TEST AIM SETUP LEARN

C ®© @ & @

STATUS COM TRIGGER GOOD READY

Figure 10 — X-PRESS™ Interface: Test Function

To exit the Test, press the X-PRESS™ push button once.

NOTE: By default, the Test exits automatically after three minutes.

The Bar Graph has the following meaning:

18
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©C @ ® O O

STATUS COM TRIGGER GOOD READY

Figure 11 — Test Function Bar Graph
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ADVANCED READER CONFIGURATION

For further details on advanced product configuration, refer to the VisiSet™ Help On-Line.
The following are alternative or advanced reader configuration methods:

Advanced Configuration Using VisiSet™

Advanced configuration can be performed through the VisiSet™ program by selecting
Device> Get Configuration From Temporary Memory to open the Parameter Setup window in
off-line mode. Advanced configuration is addressed to expert users being able to complete a
detailed reader configuration. The desired parameters can be defined in the various folders
of the Parameter Setup window and then sent to the reader memory (either Temporary or
Permanent):

File Edt Connect Disconnect Device Options Tools Help

-
MAIN MENU H parameter. Setup

RARELLH File Device Mode

M. Setup Wizard

Get [ 5end| Send Defaull:| Permanent | Inlelaclivel

F. Calibration Tool
2D Codes | 1D Codes | PostalCodes | ImageProcessing | Miscellaneous |
Feading System Layout | CBXGateway | Display | Disgnostics |
OperatingModes | Calibration | Digital /0 | LEDsAndKeypad |
DataCollction | MatchCode |  Symbol Veriication |  Commurication |

V. Symbol Verification
A.Run Mode

B. Capture Image

C. Decode Last Image

| Number Of Codes 1

D. View Last Image Code Collection Filters Disabled
E. Download Last lmage DATA FORMAT

Code Field Justification Disabled
H. Upload Bitmap I =

poat immp frae Code Field Cutting Disabled

Q. Image Buffer No Read Message <24>
3. Button Function Menu ais fischet e 2%

Statistics Field Separator String <13><10>

| Statistics Field Format %1

Symbology Identifiers Disabled

Disabled

Connection: COSI00820 on COM1 at 115200,N,8,1 Reader Status: OFF LINE MODE

Log : OFF

Figure 12 - VisiSet™ Parameter Setup Window

Host Mode Programming

The reader can also be configured from a host computer using the Host Mode programming
procedure, by commands via the serial interface. See the Host Mode Programming file on
the Mini-DVD.

Alternative Layouts

If you need to install an Ethernet network, ID-NET™ network, or Fieldbus network, refer to
the Matrix 300™ Reference Manual.

The reader can also be setup for alternative layouts by reading programming barcodes. See
the "Setup Procedure Using Programming Barcodes" printable from the Mini-DVD.

19
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2 INTRODUCTION

2.1 PRODUCT DESCRIPTION

Matrix 300™ is a Datalogic industrial compact 2D imager designed and produced to be a
high performance affordable solution for both linear and two-dimensional code reading
applications.

Matrix 300™ uses imaging technology and provides complete reading system functions by
integrating image capturing, decoding and communicating in a single compact and versatile
product.

Matrix 300™ features excellent reading and verifying performance thanks to its 1.3 Mega
pixel sensor and smart proprietary decoding libraries.

Innovative X-PRESS™ interface, combined with illuminator laser pointers for aiming,
autofocus and a Good Read Spot, enhance the ease of setup and use.

Rugged construction, IP67 protection and max 50°C operative temperature make the Matrix
300™ the ideal product for industrial applications.

Matrix 300™ has been developed for use in numerous industries like:

Automotive
= DPM (Direct Part Marked) Reading and Verification
= Tires Sorting

Electronics
= Large PCB Board Tracking
= Electronics Product Tracking

Distribution & Retail Industry

* Presentation Scanner

= Small Objects Tracking & Sorting
=  Warehouse applications

Medical & Pharmaceutical

= Medical Devices Traceability

= Pharmaceutical and Medicine Manufacturing
= Chemical & Biomedical Analysis

Food & Beverage
= Work in Progress Traceability
= Code Quality Control

This technology intrinsically provides omni-directional reading.

20
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Standard Application Program

A Standard Application Program is factory-loaded onto Matrix 300™. This program controls
code reading, data formatting, serial port and Ethernet interfacing, and many other operating
and control parameters. It is completely user configurable from a Laptop or PC using the
dedicated configuration software program VisiSet™, provided on Mini-DVD with the reader.

There are different programmable operating modes to suit various code reading system
requirements.

Quick, automatic focus, positioning, calibration and code setting of the imager can be
accomplished using the X-PRESS™ button and LEDs on top of the reader without the
necessity of a PC.

The previous functions can also be performed through VisiSet™ through the Setup Wizard.
This tool includes visual feedback from the reader.

VisiSet™ provides a Calibration Tool to verify the exact positioning of the reader and to
maximize its reading performance.

Statistics on the reading performance can also be visualized through a dedicated window in
VisiSet™.

Programmability

If your requirements are not met by the Standard Application Program, Custom Application
Programs can be requested at your local Datalogic distributor.

Some of the main features of this reader are given below:

Excellent Performance

e 1.3 MPixels (SXGA)

¢ Adjustable focus through Software controlled Liquid Lenses

e Powerful Internal Lighting Systems

¢ Outstanding decoding capability on 1D, 2D, Stacked, Postal symbologies
o Excellent performance on DPM applications

¢ Omni-directional reading

¢ Frame Rate up to 60 frames/sec

e Region Of Interest Windowing for higher frame rate

e Up to 100 readable codes in a single frame
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Ease of Setup

¢ Quick installation without PC by using X-PRESS™ interface for easy and intuitive setup
e Laser pointers for aiming

e Automatic Imager calibration and Code Settings

e Calibration Tool to verify exact code positioning in the Field of View and to maximize the
reading performance

¢ Windows-based VisiSet™ software to configure the reader parameters via PC serial or
Ethernet interface

e User-defined database of Image Acquisition Settings (parameter sets)

e Smart Fast Bracket

Ease of Use

o X-PRESS™ interface LEDs provide operational and performance feedback
e Green Spot and beeper for immediate Good Read feedback

¢ Different operating modes to suit various application requirements

e Multi Image Acquisition Settings for higher reader flexibility

e Run Time Self-Tuning for extreme reader flexibility

¢ Image saving and storage with buffering capability

¢ Diagnostic software tools

Flexible Solution
¢ Adjustable Liquid lens models

e Complete set of Accessories like mounting brackets, connection boxes, cables and
photocells

e Ethernet Connectivity with TCP/IP socket for reader parameter configuration, data and
image transfer, FTP client, etc.

e On-board Ethernet supports EtherNet/IP (explicit messaging), Profinet 1/O and Modbus
TCP protocols

e 3 serial communication interfaces (Main, Auxiliary, ID-NET™)

e General purpose I/Os

Versatility
¢ Excellent reading performance on Direct Part Marked (DPM) symbols

e Code Quality Metrics according to ISO/IEC 16022, ISO/IEC 18004, ISO/IEC 15415,
ISO/IEC 15416 and AS9132 and AIM DPM standards.

e Match Code option with a user-defined match code database
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Industrial Strength

¢ Industrial compact 2D reader

¢ Rugged metal construction

e Sealed circular connectors

e [P67 protection class

e 50 °C max operating temperature

e Supply voltage ranges from 10 to 30 Vdc

The reader is particularly suitable for industrial environments where protection against harsh
external conditions is required.

The reader is contained in an aluminum housing; with its internal illuminator, lens and
protective cover, the mechanical dimensions are 95 x 54 x 43 mm and it weighs about 238 g.

Electrical connection of Power, Host interfaces and I/O signals is provided through an M12
(IP67) 17-pin connector (Figure A, 9). A standard M12 D-Coded (IP67) Ethernet connector is
also present (Figure A, 10).

2.2 INDICATORS AND KEYPAD BUTTON

1 This product is covered jlowing US pat: || §
US6,512,218 B1; U 808,1148B1; |
US6,997,385 B2; US7,053,954 B1; US7,387,246 B2, |

TEST AIM SETUP LEARN

STATUS COM TRIGGER GOOD READY

MATRIX 300 i
i FEBRUARY 2013
> S/NB13R00018

3 |MAC Address At
10730 de  |00:07:8E:00:99:A2

Figure 13 - Indicators

The following LED indicators are located on the reader:

PWR blue LED indicates that the reader is connected to the power supply (Figure 13, 1)
NET yellow LED indicates connection to the on-board Ethernet network (Figure 13, 2)
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In normal operating mode the colors and meaning of the five LEDs are illustrated in the
following table:

READY green LED indicates that the reader is ready to operate (Figure 13, 7)

GOOD green LED confirms successful reading (Figure 13, 6)
TRIGGER |yellow LED indicates the status of the reading phase (Figure 13, 5)
COM yellow LED indicates active communication on the main serial port * (Figure 13, 4)

STATUS red LED indicates a NO READ result (Figure 13, 3)

* When connected to a Fieldbus network through the CBX500, the COM LED is always active, even in the
absence of data transmission, because of polling activity on the Fieldbus network.

During the reader startup (reset or restart phase), these five LEDs blink for one second.

In X-PRESS™ Configuration mode the colors and meaning of these five LEDs are described
in par. 2.4.

The keypad button (Figure 13, 8), is software programmable. By default it starts the X-
PRESS™ interface for quick installation without using a PC (see chp. 1).

2.3 ID-NET™
The ID-NET™ network is a built-in high-speed interface dedicated

. . . ™
for high-speed reader interconnection. ID-NET™ is in addition to
the Main and Auxiliary serial interfaces. ID NET

The following network configurations are available:

= [D-NET™ M/S Synchronized: Single station — multiple readers

&

CBX100

ID NET”

ID-NET™ interface allows local connection of multiple readers reading different sides of the
same target. All readers share a single presence sensor and activate/deactivate
simultaneously.

At the end of each reading phase a single data message is transmitted to the host.

Thanks to ID-NET™, data communication among readers is highly efficient so that an
immediate result will be available.

24



INTRODUCTION o

= |D-NET™ M/S Multidata: Multiple stations — single reader

CBX100 CBX100

ID NET"

ID-NET™ interface allows connection of readers reading objects placed on independent
conveyors. All readers are typically located far away from each other and they use a
dedicated presence sensor.

At the end of each reading phase, each reader transmits its own data message to the host.
Thanks to ID-NET™, data collection among readers is accomplished at a high speed without
the need of an external multiplexing device. This leads to an overall cost reduction and to a
simple system wiring.

2.3.1 How To Setup/Configure the Reader Network

A complete ID-NET™ reader network can be easily setup through VisiSet™ as follows:

Mounting & Connection

1. Mechanically mount/install all the readers (refer to par. 3.2 and 3.3).
2. Wire ID-NET™ (refer to par. 4.3 or Errore. L'origine riferimento non é stata trovata.).

3. Power up the entire system.

Configuration of Slaves

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Slave reader.

Launch VisiSet™ and connect to the Slave reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Slave reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Set the Slave Address according to the desired value 1-31 from the
Reading System Layout > Device Network Setting > Slave Address parameter. Each
reader must have a different Address on the ID-NET™ Network.
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6.

8.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Slave device is now Configured. Physically connect it to the Master/Slave network. If
using the CBX connection box equipped with a BM100 Backup module, you can perform
Device Backup at the Slave (see par. 2.4 for details).

The Slave device is now Configured. Repeat these steps for each Slave reader in the ID-
NET™ network.

Configuration of Master

1.

26

Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Master reader.

Launch VisiSet™ and connect to the Master reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Master reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

Enable the planned Slave device N from the Reading System Layout >
Expected Slave Device #N > Status parameter and, if desired, set the related
identification string from the Expected Slave Device #N > Device Description parameter.
Repeat this step for all planned Slave devices.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Master device is now Configured. Physically connect it to the Master/Slave network.
If using the CBX connection box equipped with a BM100 Backup module, perform a
Network Backup at the Master (see par. 2.4 for details).

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.
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£ 10-NET Status Window 3

= |

I'S!op Devices Network §oschnq] Backup ol Network ‘
Eﬁm‘é;’ﬁ;&;{é& §i§u§[€$&i§i§s}= 'IBZ::SBJEH ]§mﬁt§n§« - Iﬁ;m}; rn'
Enabled Present Matrix 300 C10P01554 Get
2 Enabled Present Matrix 300 C10P01548 Get
3 Enabled Present Matix 300 C1oP0552 Get
4 Enabled Present Matrix 300 C10P01550 Get
5 Enabled Present Matrix 300 C10P01551 Get
6 Enabled Presont Matix 300 C10P0553 Get
7 Enabled Present Matrix 300 C10P01543 Get

The reader network is ready.

2.3.2 ID-NET™ Slave Management Through Master

When an ID-NET™ layout has already been configured, it is possible to modify the
configuration of any Slave from VisiSet through the Master.

1. Connect a PC equipped with VisiSet™ to the Main, or Auxiliary interface of the Master

reader.

Launch VisiSet™ and connect to the Master reader.

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices

within the ID-NET™ network.

4. Click anywhere in the row of the specific slave in the ID-NET Status Window when its
Current Status is "Present”. The Parameter Setup window will be displayed after a time
based on the network speed, with the configuration of the selected slave.

5. From the specific Slave Parameter Setup Window, change any parameter (not in
interactive mode), save the configuration to a file, or load a configuration from a file.

6. Send the modified configuration to the slave.
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EE Parameter Setup Slave#2
File
| _send | | | |
20 Codes ] 10 Codes ] Postal Codes ] Image Processing ] Mizcellaneous
Drata Collection ] tatch Code ] Syrmbol Werification ] Communication

Reading Syatern Layout ] Mizragluph Codes ] CBx Gateway ] Digplay ] Diagrozstics

Operating Modes Calibration | Digital /0 | LEDs énd Keypad
OPERATIMNG MODE

Dperating Mode Phaze Mode

Reading Phaze O Ext. Trig. Leading Edge

Acquizition Trigger Continuous

Mumber OF Acquizsition

Acquizition Trigger Status

Reading Phaze OFF

Image Acquizition Buffer Size

Acquizition Fetry

ACQUISITION TRIGGRER DELAY

Status

Delay Time [#100u=]

0

Alwans Enabled

Ext. Trig. Trailing Edge
10

Dizabled

1
Enabled
E50

CAUTION: If a wrong configuration is set or if the Slave Reading System
Layout parameters are changed, the slave could lose the network connection.
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2.4 EXTERNAL MEMORY BACKUP AND RESTORE THROUGH
VISISET™

The "External Memory Backup" or "External Memory Restore" functions allow performing
Complete Configuration and Environmental parameter storage for network and reading
devices. Backup & Restore can be applied to any reader connected through a device having
External Backup Memory, regardless of the reader's network configuration. Backup &
Restore automatically checks whether a previous backup or configuration is already available
for each device, speeding the procedure up and making it more secure.

These functions are supported by VisiSet™ for all reading devices having sw 6.10 and later
when connected to:

e CBX + BM100 and/or BM2x0 (sw release 2.02.01 and later)

e QL500 (Ethernet TCP/IP) (sw release 2.02.01 and later)

o QLM-Series Gateways (reading device sw release 6.50 and later)

NOTE:
e Before executing a Backup on a BM100 backup module make sure the Write

Protection switch is set to Unlocked.

e If BM100 and BM2x0 are both installed B&R is automatically performed only on
the BM100 module.

e BM2x0 can execute B&R only with Network up and running (network cable
connected).

e QL500 can backup up to 10 nodes (Master + 9 slaves).

Backup

To perform a Backup:

1. Select "External Memory Backup" from the VisiSet™ Device menu
2. You will be warned that the previous backup will be overwritten. Confirm by clicking Yes.

E Confirmation

Start Configuration Backup?

(Old backup will be overwritten)

o Yes | X No
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The VisiSet™ Main window shows information as the backup procedure is performed and a
message indicating successful completion.

& visiSet
Fle Edt Connect Desconnect Devics Options Tools Heb

MAIN MENU
Device: Matrix 300

M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibr ation Tool
Standard Application Program for Matrix Family Rel. 6.60
}. Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
A. Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture Image Gateway: 172.27.2.254
DNS1: 172.27.0.32
Backing up local device (Master)...
Local device (Master) successfully backed up
Backing up Slave 1...
E. Download Last lmage Slave 1 successfully backed up
Backup module updated!
External Memory Backup procedure successfully completed.

C. Decode Last image

D. View Last Image

H. Upload Batmap image

Connection: 813000018 on 172.27.101.151 Resder Status: OFF LINE MOOE Log : OFF

Restore

To perform a Restore:

1. Select "External Memory Restore" from the VisiSet™ Device menu

2. You will be warned that the current device configuration(s) will be overwritten. Confirm by

clicking Yes.
E Confirmation @

Start Configuration Restore?

{Current configuration in device will be overwritten)

X No
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The VisiSet™ Main window shows information as the restore procedure is performed and a
message indicating successful completion.

Fis Edt Comnect Disconnect Device Options Tooks Help

MAIN MENU

M. Setup Wizard

F. Calibration Tool

). Data Matrix Setup Wizard
A. Run Mode

B. Capture image

C. Decode Last Iimage

D. View Last image

E. Download Last Image

H. Upload Bitmap Image

Q. Image Buffer

3. Button Function Menu

Device: Matrix 300
Model: 412-010
Communication Port: Ethernet

Standard Application Program for Matrix Family Rel. 6.60
MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
Gateway: 172.27.2.254
DRS1: 172.27.0.32
Restoring local device (Master)...
Local device (Master) successfully restored
Checking configuration...0K
Contfiguration saved in Permanent memory!
Local device updated!
Checking for ID-NET Slaves...
Restoring Slave 1...
Slave 1 successfully restored
External Memory Restore procedure successfully completed.

[Connection: B13P0001S on 172.27.101.151 Readér Status: OFF LINE MODE Log : OFF

Replacement

The External Memory Restore function also provides easy and secure Single Device

Replacement:

Remove the device to be replaced

Connect the new device (make sure the new device has been previously set to default)

Run the Restore procedure by selecting the "External Memory Restore" item (see:

Restore procedure)

31



o MATRIX 300™ REFERENCE MANUAL

Erase

To Erase any previous Backup:

1. Select "External Memory Erase" from the VisiSet™ Device menu

2. You will be warned that all device configurations in the current backup will be erased.
Confirm by clicking Yes.

H Confirmation

Any Configuration present in current Backup will be erased

Are you sure you want to proceed?

................................

L of Yes X No

The VisiSet™ Main window shows a message indicating successful completion.

Fie Edt Connect Disconnect Device Oplions Tooks Help

MAIN MENU
Device: Matrix 300
M. Setup Wizard Model: 412-010
Communication Port: Ethernet
F. Calitw ation Tool
Standard Application Program for Matrix Family Rel. 6.60
). Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
A. Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture image Gateway: 172.27.2.254
DNS1: 172.27.0.32

Backup module erased!
External Memory Erase procedure successfully completed.

C. Decode Last Image
D. View Last image

E. Download Last Image
H. Upload Bitmap Image
Q. Image Buffer

3. Button Function Menu

(Connection: B13P0001S on 172.27.101.151 Reader Status: OFF LINE MODE Log : OFF
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List

To see a List of the current Backup:

1. Select "External Memory Read Backup" from the VisiSet™ Device menu.

The VisiSet™ Main window shows a list of devices in the current Backup.

Fie Edt Connect Disconnect Device Oplions Tooks Help

MAIN MENU
Device: Matrix 300

M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibration Tool

). Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.
IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture image Gateway: 172.27.2.254

DHS1: 172.27.0.32
C. Decode Last Image List of backup present on External Memory:

MASTER:Matrix 300
SLAVE 1:Matrix 300

A. Run

D. View Last image
E. Download Last Image
H. Upload Bitmap Image
Q. Image Buffer

3. Button Function Menu

(Connection: B13P0001S on 172.27.101.151 Readér Status: OFF LINE MODE

Standard Application Program for Matrix Family Rel. 6.60

Log : OFF

The following is a list of possible error messages displayed on
case of an External Memory function failure:

the VisiSet™ main window in

e Module not present: backup module not mounted (BM100) or not ready (QL500,

BM2x0)

e Unable to Read Backup State: VisiSet™ is unable to connect to the backup memory
e Backup function not allowed: when device is in X-PRESS™ Menu mode (BM100,

QLM) or is out of memory (QL500)

o Failed! (Device not found): Master is unable to reach the addressed device
o Failed! (Module is write protected): BM100 Write Protection switch is set to Locked
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2.5 X-PRESS™ HUMAN MACHINE INTERFACE

X-PRESS™ is the intuitive Human Machine Interface designed to improve ease of
installation and maintenance.

Status information is clearly presented by means of the five colored LEDs, whereas the
single push button gives immediate access to the following relevant functions:

e Learn to self-detect and auto-configure for reading unknown codes
e Setup to perform Exposure Time and Gain calibration
¢ Aim/Autofocus to turn on the laser pointers to aid positioning and focusing

e Test with bar graph visualization to check static reading performance

2.5.1 X-PRESS™ Functions

Quick access to the following functions is provided by

an easy procedure using the push button: ey
1 — Press the button (the Status LED will gi ee0 90
glve a STATUS COM TRIGGER GOOD READY
visual feedback).
2 — Hold the button until the specific function LED is @
on (Test, Aim, Setup or Learn).

3 — Release the button to enter the specific function.

Once button is pressed, the cycle of LEDs activation is as follows:

AIM  SETUP LEARN

TEST AIM SETUP LEARN TEST AIM SETUP LEARN

@ O ®©e 6 @ @ O BN BN BN )
STATUS COM TRIGGER GOOD READY STATUS COM TRIGGER GOOD READY STATUS COM TRIGGER GOOD READY
> > >
Release button Release button Release button
to Exit to enter Test Mode to enter Aim/Autofocus Mode

TEST AIM SETUP LEARN TEST AIM SETUP LEARN TEST AM SETUP LEARN

O @ ® O @ O @ ® O O C ® @ & @
STATUS COM TRIGGER GOOD READY STATUS COM TRIGGER GOOD READY STATUS COM TRIGGER GOOD READY
> > => (cycle)
Release button Release button Release button
to enter Setup Mode to enter Learn Mode to Exit
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Test Mode (Function 1)

Once entered, the Bar Graph on the five LEDs is activated and if the imager starts reading
codes the Bar-Graph shows the Good Read Rate. In case of a NO READ condition, only the
Status LED is on and blinks.

The Bar Graph has the following meaning:

TEST AIM SETUP LEARN

©C @ ® O O

STATUS COM TRIGGER GOOD READY

To exit the Test Mode, press the X-PRESS™ push button once.

NOTE: By default, the Test exits automatically after three minutes.

Aim/Autofocus (Function 2)

This function causes the laser pointers to turn on. Since the laser pointers are centered on
the FOV they can be used to position the imager on the code. The Aim LED blinks to indicate
this state. After a short delay, this function also performs the Autofocus procedure for Liquid
Lens models.

You can exit the Aim/Autofocus function at any time by pressing the X-PRESS™ push button
once. After a short delay the autofocus procedure is cancelled and the laser pointers turn off.

Setup (Function 3)

Once entered, the imager automatically performs Image Acquisition parameter calibration for
the specific code presented to it.

The Setup LED will blink until the procedure is completed.

The Setup procedure ends when the Image Acquisition parameters are successfully saved in
the reader memory, the Setup LED will stop blinking and Matrix 300™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout of about 5 (five) seconds Matrix 300™ will
exit without saving the parameters to memory, the Setup LED will stop blinking and in this case
Matrix 300™ emits a long low pitched beep.
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Learn (Function 4)

Once entered, the imager starts a procedure to automatically detect and recognize codes
which are presented to it.

The Learn LED will blink until the procedure is completed.

The Learn procedure ends when the Image Processing and Decoding parameters are
successfully saved in the reader memory, the Green Spot is activated, the Learn LED will stop
blinking and Matrix 300™ emits 3 high pitched beeps.

If the autolearning cannot be reached after a timeout of about 3 (three) minutes, Matrix 300™
will exit without saving the parameters to memory, the Learn LED will stop blinking and in this
case Matrix 300™ emits a long low pitched beep.

You can exit the Learn function at any time by pressing the X-PRESS™ push button once.
After a short delay the Learn procedure is cancelled.

2.5.2 Diagnostic Indication

The “STATUS” and “READY” LEDs blink simultaneously while the "GOOD" LED is on to
signal the presence of an error. Diagnostic message transmission on interfaces can be
enabled to provide details about specific error conditions. See the Diagnostic Error
Conditions chart in the Help On Line.

LED STATUS
TEST AM SETUP LEARN
® ® O O READY BLINK
STATUS COM TRIGGER GOOD READY GOOD ON to indicate an error

TRIGGER
COM

STATUS BLINK

2.6 MODEL DESCRIPTION

Matrix 300™ readers are described by their model number which indicates the
characteristics listed in the diagram below. Not all combinations are available. For a
complete list of combinations see the Models tab on the Product page of the website.

MATRIX 300 4XX-0XX

Internal IIIuminator Og*tions

1 = Wide Angle Red 0 = Standard

5 = Wide Angle White 1= ESD Safe

7 = Light DPM 2 = ESD Safe + YAG Cut Filter

8 = Multi-Light DPM

y

Lens Type Input Power
1 =6 mm (fixed lens manual focus) 1 = Standard 10 - 30 Vdc
2 =9 mm (liquid lens auto focus) 4 = PoE 48 Vdc
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2.6.1 Lighting System Notes

The following table shows the Matrix 300™ lens/illuminator combinations. For more
information see the Application Note on illuminator selection on the mini-DVD.

Matrix 300 Models

Internal llluminators

Model Lens Type LEDs | Type
Matrix 300 411-0xx 6 mm Fixed Lens 8 Red Wide Angle
Matrix 300 481-0xx 24/39 | Red Bright/Blue Dark Field DPM (sw configurable chains)

Matrix 300 412-0xx
Matrix 300 452-0xx
Matrix 300 472-0xx
Matrix 300 482-0xx

9 mm Liquid Lens

8 Red Wide Angle

8 White Wide Angle
24/26
24/39

Red Bright Field DPM (sw configurable chains)
Red Bright/Blue Dark Field DPM (sw configurable chains)

2.7 ACCESSORIES

The following accessories can be used with the Matrix 300™ reader.

Accessory Description Order No.
Cables
CAB-DS01-S M12-IP67 Cable To CBX or QL (1M) 93A050058
CAB-DS03-S M12-IP67 Cable To CBX or QL (3M) 93A050059
CAB-DS05-S M12-IP67 Cable To CBX or QL (5M) 93A050060
CAB-ETH-M01 M12-IP67 Ethernet Cable (1M) 93A051346
CAB-ETH-M03 M12-IP67 Ethernet Cable (3M) 93A051347
CAB-ETH-MO05 M12-IP67 Ethernet Cable (5M) 93A051348
CBL-1534.02 Adapter Cable Ethernet M12 to RJ45 93A050057
CBL-1480-01 Thin M12/5P Male/Female (1M) 93A050049
CBL-1480-02 Thin M12/5P Male/Female (2M) 93A050050
CBL-1490 Term. Resist. Thin M12/5P/Male 93A050046
CBL-1496 Term. Resist. Thin M12/5P/Female 93A050047
Connectivity
CBX100 Compact Connection Box 93A301067
CBX500 Modular Connection Box 93A301068
BM100 Backup Module for CBX100/500 93ACC1808
BM150 Display Module for CBX500 93ACC1809
Various Fieldbus and Non-Fieldbus Host Interface Modules and All-In-One Connection Box Kits are available
BA100 DIN Rail Adapters 93ACC1821
BA200 Bosch Adapters 93ACC1822
Various M12 Panel Connectors for CBX Connection Boxes are available
BA900 Two Cable Glands Panel 93ACC1847
QL100 Quick Link Slave ID-NET T-Connector 93ACC1860
QL150 Quick Link Slave ID-NET + Service T-Connector 93ACC1868
QL200 Quick Link Slave ID-NET + Power T-Connector 93ACC1861
QL300 Quick Link Master ID-NET - Serial Host Connector 93ACC1862
uick Link Master ID-NET - Ethernet Host Connector
QL500 Ei?ncludes Ethernet/IP explicit messaging) 93ACC1864
QLM500 Quick Link Metal Master ID-NET - EthernNet/IP Gateway 93ACC0037
QLM600 Quick Link Metal Master ID-NET - Profibus Gateway 93ACCO0033
QLM700 Quick Link Metal Master ID-NET - Profinet I/O Gateway 93ACC0038

Various M12 Se

rvice Cables and Field Mount Connectors are available for Quick Lin

k Series Connectors

Power Supplies

PG6002 AC/DC Power Supply Unit (US) 93ACC1718
PG6001 AC/DC Power Supply Unit (UK) 93ACC1719
PG6000 AC/DC Power Supply Unit (EU) 93ACC1720
Sensors

MEP-593 Photocell Kit PNP (PH-1) 93ACC1791
MEP-543 Photocell Kit-NPN 93ACC1728
S3Z-PR-5-C11-PL Diffuse Proximity Sensor 95B010011
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2.8 APPLICATION EXAMPLES
2.8.1 Document Handling

Matrix 300™ is profitably used in the omnidirectional reading of 2D, stacked, linear and
postal codes for example in automated document handling and mail processing systems
(see Figure 14).

Figure 14 - Address Coded in Data Matrix Symbology for Automated Mail Processing

2.8.2 Deformed or Overprinted Code Reading

Matrix 300™ assures the reading of deformed and / or overprinted codes, even though
damaged or printed on high reflective surfaces (see Figures 17, 18, 19).

XXX XXXXX)
X000 (X}
OO0 XX XXX

P
S XXX XX)
e
) [0 MK
.  t—— e

Figure 17 - Barcode Printed on Curved Surface Readable by Matrix 300™ in spite of Image Optical
Distortion
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2.8.3 Direct Part Marking

Matrix 300™ is also very powerful in reading low-contrast direct part marked codes (see
Figures 20, 21, and 22).

Figure 18 - Dot Matrix Code Directly Marked on Metal Surface by Using Dot Peening Technology

Figure 19 - Dot Peening Marking on Metal Surface with Multi-dot per Code Element

Figure 20 - Directly Marked Dot Matrix Code Characterized by Outstanding Separation Distance between
Adjacent Code Elements

2.8.4 Ink-Jet Printing Technology

Figure 21 - Dot Matrix Code Directly Marked on PCB Copper Pad by Using Ink-Jet Technology
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2.8.5 Laser Marking/Etching Technology

Q”" "
oﬁ\ &

Figure 22 - Data Matrix Code Directly Marked on PCB Surface by Using Laser Etching Technology

f CAUTION: If application codes must be read which are produced by Laser

Marking in real time, use Matrix 300™ models incorporating YAG Filters in
order to avoid burning the CMOS sensor.




INSTALLATION

3

INSTALLATION

3.1 PACKAGE CONTENTS

Verify that the Matrix 300™ reader and all the parts supplied with the equipment are present
and intact when opening the packaging; the list of parts includes:

a

Matrix 300™ reader
Quick Reference Guide
Test Charts (2)

Matrix family Mini-DVD

Mounting Kit

¢ Mounting Screws (4 + 2)
e Washers (2)

e Mounting Brackets (2)

Figure 23 - Package Contents
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3.2 MECHANICAL DIMENSIONS

Matrix 300™ can be installed to operate in different positions. The twelve screw holes (M4 x
5) on the body of the reader are for mechanical fixture (Figure 24).

The diagram below gives the overall dimensions of the reader and may be used for its
installation.

Refer to par. 3.3 for various mounting solutions and correct positioning and chp. 6 for FOV
vs. Reading Distance considerations.
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! Connector block
rotates to 90° position

Figure 24 - Overall Dimensions with Connector at 0°
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Figure 25 - Overall Dimensions with Connector at 90°
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Figure 26 - Mounting Bracket Overall Dimensions

in




INSTALLATION o

3.3 MOUNTING AND POSITIONING MATRIX 300™

Using the Matrix 300™ mounting brackets you can obtain rotation on the various axes of the
reader as shown in the diagram below:

— ——tl
7

LN

Y
J
Q
=< |
S
1
£

SIOATALOGIC

Figure 27 —Positioning with Mounting Bracket
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Matrix 300™ is able to decode code labels at a variety of angles; however significant angular
distortion may degrade reading performance.

When mounting Matrix 300™, take into consideration these ideal label position angles: Pitch
or Skew 10° to 20° and Tilt 0°.

Note: Since Matrix 300™ is omni-directional on the code plane, the Pitch and Skew angles
have the same significance with respect to the code plane. However in some advanced code
reading applications performance can be improved by modifying the Skew angle.

The Pitch, Skew and Tilt angles are represented in Figure 28. Follow the suggestions below
for the best orientation:

Position the reader in order to avoid the direct reflection of the light emitted by the Matrix 300™
reader; it is advised to assure at least 10° for the Skew angle.

Tt Skew
! Assure at least 10°
any angle
. within FOV
Pitch
Minimize

No Pitch, Tilt or Skew

Figure 28 - Code Reading Orientation

In some cases, such as low contrast or low illumination, it can be useful to use a Pitch or
Skew angle = 0°.

The Tilt angle is also represented in Figure 29. Matrix 300™ can read labels with any tilt
angle. Keep in mind however, that since linear barcodes are rectangular, the reader should
be aligned to fit them into the horizontal FOV.
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4 CBX ELECTRICAL CONNECTIONS

All Matrix 300™ models can be connected to a CBX connection box through one of the
available CAB-DSxx-S accessory cables. These accessory cables terminate in an M12 17-
pin connector on the Matrix 300™ side and in a 25-pin male D-sub connector on the CBX
side.

We recommend making system connections through one of the CBX connection boxes since
they offer the advantages of easy connection, easy device replacement, opto-isolated
outputs (Outputs 1 and 2), and filtered reference signals.

NOTE: If you require direct wiring to the reader the connections are the
same as shown in this chapter with the exception of the digital Outputs. Direct
wiring details are indicated in Appendix A

The table below gives the pinout of the CBX100/500 terminal block connectors. Use this
pinout when the Matrix 300™ reader is connected by means of the CBX100/500:

CBX100/500 Terminal Block Connectors

Input Power
Vdc Power Supply Input Voltage +
GND Power Supply Input Voltage -
Earth Protection Earth Ground
Inputs
+V Power Source — External Trigger
I11A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger
+V Power Source — Inputs
I2A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference — Inputs
Outputs
+V Power Source - Outputs
-V Power Reference - Outputs
O1+ Output 1 + opto-isolated and polarity sensitive
O1- Output 1 - opto-isolated and polarity sensitive
02+ Output 2 + opto-isolated and polarity sensitive
02- Output 2 - opto-isolated and polarity sensitive
03A Output 3 non opto-isolated (only available on CBX500)
Auxiliary Interface
TX Auxiliary Interface TX
RX Auxiliary Interface RX
SGND Auxiliary Interface Reference
ID-NET™
REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -
Shield Network Cable Shield
Main Interface
RS232 RS485/422 Full-Duplex
TX TX+
RX *RX+
RTS TX-
CTS *RX-
SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.
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NOTE: To avoid electromagnetic interference when the reader is connected
to a CBX connection box, verify the jumper positions in the CBX as indicated

in its Installation Manual.

4.1 POWER SUPPLY

Power requirements and conditions depend on the Matrix 300™ model: Standard or PoE
(Power over Ethernet).

4.1.1 Standard Models

For these models power can be supplied to the reader through the CBX100/500 spring clamp
terminal pins as shown in Figure 30:

Power Supply
VGND

V+ Earth

in Ground

|| s | o} s | | || |

000000000

vde GND|<&, [REF D+ D- [& [sexo Tx RIS Rx cTs 1
POWER 7% ID-NET % | MAIN R)TX+ (RITX- RX+ RX-

Figure 30 - Power Supply Connections
The power must be between 10 and 30 Vdc only.
It is recommended to connect the device CHASSIS to earth ground (Earth) by setting the
appropriate jumper in the CBX connection box. See the CBX Installation Manual for details.
4.1.2 Power over Ethernet (PoE) Models

The Ethernet pinout is as follows:

Figure 31 - M12 D-Coded Female Ethernet Network Connector

Power over Ethernet Network Connector Pinout
Pin Name Function
1 TX +/DC- Transmitted data (+) DC power (-)
2 RX +/DC+ Received data (+) DC power (+)
3 TX -/IDC- Transmitted data (-) DC power (-)
4 RX -/DC+ Received data (-) DC power (+)
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CAUTION: Matrix 300™ PoE models only accept Alternative A (power

over RJ45 pins 1, 2, 3, 6), Class 0 power levels. Use an Endspan or
Midspan PSE device that supports this configuration (i.e. POE switch or
Power over Ethernet Adapter).

Alternative B (power over RJ45 pins 4, 5, 7, 8) using an Endspan or
Midspan PSE device is not supported.

PSE Endspan Matrix 300
RJ45 Ethernet Connector M12 Ethernet Connector
)
j a- E
Positive + @
48 Vdc CAB-ETH-MO0x Cable (RJ45 to M12) 4-pin

Negative - .0

- 00000000000 T

3

Figure 32 — Matrix 300™ PoE PSE Endspan Alternative A Connections OK

Non PoE Ethernet Switch PSE Midspan Matrix 300
RJ45 Ethernet Connector RJ45 Ethernet Connectors M12 Ethernet Connector
Data Pair E Data Pair
Fositive+ CAB-ETH-MOX
48 Vdc (RJ45 to M12) 4-pin
Negative -
Data Pair ‘E Data Pair

Figure 33 — Matrix 300™ PoE PSE Midspan Alternative A Connections OK

PSE Endspan
RJ45 Ethernet Connector

Matrix 300
M12 Ethernet Connector

E Data Pair

Data Pair %” “g Data Pair

Figure 34 — Matrix 300™ PoE PSE Endspan Alternative B Connections NOT SUPPORTED

Positive +
48 Vdc
Negative -
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Non PoE Ethernet Switch PSE Midspan Matrix 300
RJ45 Ethernet Connector RJ45 Ethernet Connectors M12 Ethernet Connector
Data Pair E Data Pair
CAB-ETH-MOx
(RJ45 to M12) 4-pin
Data Pair ‘E Data Pair

Figure 35 — Matrix 300™ PoE PSE Midspan Alternative B Connections NOT SUPPORTED

circuitry is not powered and supply power is not available to any Input/Output
devices (Vdc=0). Only input device signals can be accepted directly on the
M12 17-pin connector without power.

For these models, if it is necessary to use Input/Output devices, we recommend
connecting them through the CBX, which must be powered separately.

i CAUTION: For Matrix 300™ PoE models, the internal Digital Output

See par. 4.7 for further details.

4.2 MAIN SERIAL INTERFACE

CAUTION: Do not connect to the Main Interface spring clamp terminals if
using Host Interface Modules (Fieldbus) with the CBX500.

The signals relative to the following serial interface types are available on the CBX spring
clamp terminal blocks.

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. For more details refer to the
"Communication" folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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4.2.1 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins are used for RS232 interface connection:

CBX100/500 Function
TX Transmit Data
RX Receive Data
RTS Request To Send
CTS Clear To Send
SGND Signal Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

USER INTERFACE
SGND RXD TXD

CTS RTS

| | —

00000 W
S 1 ‘

o[l
O[l

Vdec GND REF ID+ ID- 6}5/ SGND TX RTS RX CTs
POWER % ID-NET % | mAN RITX+ RITX- Rx+  Rx-

READER SGND TX RX
RTS CTS

Figure 36 — RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START END
OF OF
,  TRANSMISSION TRANSMISSION
+
RTS
NV —ff— —
ﬂ DATA DATA !
‘v | TRANSMISSION TRANSMISSION |
TX DATA I Jcifca) (csfcalcs) |
SV —
n TRANSMISSION n
H | STOPPED ﬂ
n n | n
| ENABLED | | EnaBLED |
+V —
-V
IDLE DISABLED i

Figure 37 - RS232 Control Signals

If the RTS/CTS handshaking protocol is enabled, the Matrix 300™ activates the RTS output
to indicate a message is to be transmitted. The receiving unit activates the CTS input to
enable the transmission.
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4.2.2 RS485/422 Full-Duplex Interface

The RS485/422 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The CBX pinout follows:

CBX100/500

Function

TX+
RX+
TX-
RX-
SGND

RS485/422 Transmit Data +
RS485/422 Receive Data +
RS485/422 Transmit Data -
RS485/422 Receive Data -

Signal Ground

USER INTERFACE

RX485+ TX485+

TX485-

| | —

000

REF ID+
ID-NET

Vdc GND
POWER

Qll
Ol
< Ol

ID-

% | MAIN (RITX+ (R)TX-  RX+

&%, |SGND TX RTS RX CTS

RX-

|

READE

R

SGND TX+ RX+
TX-

RX-

Figure 38 - RS485/422 Full-duplex Connections

NOTE: For applications that do not use RX signals, do not leave these lines
floating but connect them to SGND as shown below.

USER INTERFACE

RX485+

SGND M RX485-

o | [ e | e [ | e} [ e | [ | [
vdc GND |, [REF 1+ -8 [seno 1x RIS Rx cTs
POWER "% ID-NET % | MAIN (RITX+ RITX- Rx+ Rx- |1
READER SGND TX+

TX-

Figure 39 - RS485/422 Full-duplex Connections using Only TX Signals

53



0 MATRIX 300™ REFERENCE MANUAL

4.3 ID-NET™ INTERFACE
CBX100/500 Function
Shield Network Cable Shield
ID+ ID-NET™ network +
ID- ID-NET™ network -
REF Network Reference

4.3.1 ID-NET™ Cables

The following instructions are referred to Figure 41, Figure 42 and Figure 43.

The general cable type specifications are: CAT5 twisted pair + additional CAT5 twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 - |[EC 62026
UL STYLE 2502 80°C 30V

Cable Shield MUST be connected to earth ground ONLY at the Master.
NEVER use ID-NET™ cable shield as common reference.

The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
For Common Power Connections use only 2 wires (ID+ and ID-).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

Reader's chassis may be connected to earth.

Network inside the same building.

Baudrate Table

Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps

Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.
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4.3.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the
Host.

Max ID-NET™ Response Time

240

220 1>

200 -

180 o

160 Lo

140 et

120 On

100 = —=

et

80 ~ o

Response Time (ms)
\

60 ‘t‘ /

40

20

o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Nodes
— 500 kbps = = =+ 250 kbps = =eeseeee 125 kbps

Figure 40 — ID-NET™ Response Time

CONDITIONS:

e ID-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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CBX100/500 Main Interface HOST
Reader 4 I E|/ RS232/RS485
Master E s | (s
. . ° Shield
. H\\i\ o | [shield <
S IHIEN iD-
—— ~ 1D+
ID-NET™
Termination Resistor. BN REF A\
PG-6000 Earth
E—
Vdc *
A
o
)
CBX100/500 Shield o
S . < D- (blue) w
Reader Sl e D+ |(White) = 5
° . ° Q.
Slave o e Lle rer (12K s 5
#1 M H\ : 1 shieta L ® m
o | [lsl Tysl ] ricating] |shield T 5+
M P ID- T 0O
. . a q @ Q
ID-NET™ ID+ g Z
Termination Resistor. O REF — 5 ]
PG-6000 Earth 2
GND _-|T_ §
Vdc Q
>
CBX100/500 Shield
S 5 S D- (blue)
Reader el []e D+ |-(White)
Slave M . ; REF (black) v
: L] L ) 1 ie
(up to 31) . . ; Tfﬁ:;ti:\dgl
ID-NET™ ~
Termination Resistor. O
PG-6000 Earth __l_

GND L
Vdc

Figure 41 — ID-NET™ Network Connections with isolated power blocks
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CBX100/500 Main Interface HOST
Reader s |ls } RS232/RS485
Master s (e s
. j\ . Shield
° . . to "
° ° \*:} E Shield
. : $ arth = 7 A
e || P D+ \ )
ID-NET™ A
Termination Resistor. BN REF
Earth
GND _-|:—
Vdc *
A
©
)
CBX100/500 Shield o
< < < ID- (blue) w
Reader s e e i+ | White) 8 _
[ ] L ) [ ] Q U
Slave o | e Lle REF s >
#1 . j\ . 1 shietd L ® m
° ° \~= Ifloating| Shield -1 S' -
: . . ID- /—\ (=2 O
[ ] L ) @] |D+ \ } [ m
ID-NET™ ~ g Z
Termination Resistor. O REF 5 ()
o
Earth 3
® GND _-I_- §
Vdc Q
=2
CBX100/500 Shield
o . o ID- (blue)
Reader 5 S 5 D+ |(White) v
o |5 T s
(up to 31) |
ID-NET™ —
Termination Resistor. O
Earth
GND _-lf—
T Vdc
POWER
SOURCE
12-24 Vdc

Figure 42 - ID-NET™ Network Connections with Common Power Branch Network

57



MATRIX 300™ REFERENCE MANUAL

CcBXx1 00/5(& Main Interface HOST
Reader K ]/ RS232/RS485
Master E . | s
M . o Shield
. B\ < | Ve, | [Shield 7y
IR EN o (\}
ID-NET™ ] D+
Termination Resistor. O REF
Earth
GND _-lf—
Vdc *
A
o
)
CBX100/500 Shield o
" - < ID- (blue) o
Reader sl 1] D+ |(White) 8 _
[ ) [ ] [ ] Q— U
Slave : o L3 REF § |Z
#1 . H\ . 1 shieia Lo m
. ° o] Ifloating| Shield - Q_)| -
: Y . ID- m (=3 (@)
[+ | [+ |l= e\ ° o
ID-NET™ < g g
Termination Resistor. O REF 5 ()
)
Earth X
GND _-l_- §
Vdc cg_
>
CBX100/500 Shield
— G o | (blue)
Reader E E : D+ |(White) 4
o ST s
(up to 31) LB )
ID-NET™
Termination Resistor. O
Earth
GND j:—
I I Vdc
POWER
SOURCE
12-24 Vdc

Figure 43 — ID-NET™ Network Connections with Common Power Star Network
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4.3.3 ID-NET™ Network Termination

The network must be properly terminated in the first and last reader of the network. This is
done by setting the ID-NET™ Termination Resistance Switch in the CBX100/500 to ON.

4.4 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication
folder of the VisiSet™ utility program.

The 9-pin female Auxiliary Interface connector inside the CBX is the preferred connector for
device configuration or communication monitoring.

5 1

00000
[ONONOXO)
EE—

9 6

Figure 44 - 9-pin female connector

If permanent system wiring is required, the following pins are used to connect the RS232
auxiliary interface:

CBX100/500 Function
RX Auxiliary Interface Receive Data
TX Auxiliary Interface Transmit Data
SGND Auxiliary Interface Reference

USER INTERFACE
RX TX

 —
+ v o1+ O01- 02+ O02-|+v 12A 2B -v | X RX
OUTPUTS INPUT2 AUX

Ol
Ol
o[l
o[l
o[l
o[l
o[l
o[l
Ol

ENI

I

O

Vdc GND REF D+ ID-[& |+ 1A 1B v s 5
POWER % ID-NET % TRIGGER

o[l
o[l
> Ofl
o[l
O[l
O[l
o[l
o[l
o[l
O[l

Reference

Figure 45 - RS232 Auxiliary Interface Connections

NOTE: Do not connect the Aux Interface to the CBX spring clamp
connectors and the 9-pin connector simultaneously.
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4.5 INPUTS

There are two optocoupled polarity insensitive inputs available on the reader: Input 1
(External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
¢ reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
e match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Vg = 30 Vdc max.
Iy = 10 mA (reader) + 12 mA (CBX) max.

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the default
minimum pulse duration is = 0.5 milliseconds. This value can be increased or decreased
through the software parameter Debounce Filter, see the Digital I/O folder in the VisiSet™
Help On Line for further details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

NOTE: Polarity insensitive inputs assure full functionality even if pins A and
B are exchanged.

The connections are indicated in the following diagrams:

CBX100/500 Function
+V Power Source - External Trigger
1A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference - External Trigger

The yellow Trigger LED (Figure 13, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 300™ POWER

the Input Device on the +V/-V spring clamps, and does not pass through the
Power Switch (ON/OFF) inside the CBX. Disconnect the power supply when

working inside the CBX.

i CAUTION: Power from the Vdc/GND spring clamps is available directly to

PH-1 Photocell (PNP)

(brown)

(black) (blue)

|| — o | | o || o | | | —l —l

seeee e I I {®

REF D+ ID- [ | +v 1A 1B v SGND|,
% TRIGGER AUX

Vdc  GND
POWER "% ID-NET

Figure 46 — PH-1 External Trigger Using Matrix 300™ Power

NPN Photocell

Power to Input

Photocell Signal
Photocell
Reference
— | | s | | o | e — —

Vdc GND
POWER "% ID-NET

o || |
&, |rReF b+ - ]S | +v 1A 1B v [senp
% TRIGGER AUX

Figure 47 - NPN External Trigger Using Matrix 300™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

PNP Photocell

Input
Signal

Pulled down to External
Input Device Reference

| | — | | o || o || e | | | w—

0000000 0®®00

Rer D+ - |9 [+v 1A 118 v [seno|,
% TRIGGER AUX

Vdc GND
POWER % ID-NET

Figure 48 - PNP External Trigger Using External Power

NPN Photocell

Pulled up to External
Input Device Power

Input

Signal
| | o | | | { s | s | s [
Vdc GND | <&, |REF 1D+ ID- | +V  1MA 1B -V [seND
POWER % ID-NET % TRIGGER AUX

Figure 49 - NPN External Trigger Using External Power
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CBX100/500 Function
+V Power Source - Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference - Inputs

INPUT 2 CONNECTIONS USING MATRIX 300™ POWER

CAUTION: Power from the Vdc/GND spring clamps is available directly to
the Input Device on the +V/-V spring clamps, and does not pass through the
Power Switch (ON/OFF) inside the CBX. Disconnect the power supply when
working inside the CBX.

Input Device

Power to

Input Device
Input Input Device
Signal Reference
| | o | s | | s — [
0000 e®) Qe OO

+V

-V

O1+ 0O1- 02+ 02-] +V I2A  12B

OUTPUTS INPUT2

-V

T

RX

AUX

PNP Input 2 Using MATRIX 300™ Power

Input Device

Power to Input

Input Device Signal

Input Device
Reference
| | o | s | | s — [
+V -V 01+ 0O1- 02+ 02-] +V I2A  12B -V X RX
OUTPUTS INPUT2 AUX 3

NPN Input 2 Using MATRIX 300™ Power

INPUT 2 CONNECTIONS USING EXTERNAL POWER

Input Device

Input
Signal

Pulled down to External
Input Device Reference

 —

 —

o || | | |

 —

 —

 —

O

O

O|0|00O

O

O

O

+V

-V

O1+ O1- 02+ 02-| +V I2A 2B
OUTPUTS INPUT2

-V

T

RX

AUX

d

Figure 50 - PNP Input 2 Using External Power
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Input Device

Pulled up to External
Input Device Power

Input
Signal

s | o | s | s | o | s | s | o || — |

90000 e® OO0

+V -V 01+ 0O1- 02+ 02-| +V I2A 2B -V T RX
OUTPUTS INPUT2 AUX

d

Figure 51 - NPN Input 2 Using External Power

INPUT 3 CONNECTIONS (CBX500 Only)

RESERVED

o || o | | | | | | | e o || o || — |

Ol0I0RIOIOR®IOO0O

03A 03B +V 13A KA v 134B 134B |8 [SGND RTX+ RTX-
OTHER I/0 % MAIN

Figure 52 - Input 3 Using External Power

i CAUTION: Do not connect to I3A or 134B signals, they are reserved.
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4.6 OUTPUTS

connection box, they become opto-isolated and polarity sensitive and acquire
the electrical characteristics listed below. To function correctly, they require
setting the Qutput Type configuration parameters to NPN for the respective
output in.

f CAUTION: When Outputs 1 and 2 are connected through the CBX

Three general purpose outputs are available and their meaning can be defined by the user.
They are typically used either to signal the data collection result or to control an external
lighting system.

CBX100/500 Function
+V Power Source - Outputs
o1+ Output 1 + opto-isolated and polarity sensitive
01- Output 1 - opto-isolated and polarity sensitive
02+ Output 2 + opto-isolated and polarity sensitive
02- Output 2 - opto-isolated and polarity sensitive
O3A Output 3 non opto-isolated (only available on CBX500)
-V Power Reference Outputs

The electrical features of the outputs are the following:

Outputs 1 and 2 Output 3

Vce = 30 Vdc max. Reverse-Polarity and Short-Circuit Protected
Ice = 40 mA continuous max.; 130 mA pulsed max. | Vout (lLoap = 0 mA) max = 30 Vdc

VCE saturation — 1 Vdc max. @ 10 mA VOUT (ILOAD =100 mA) max = 3 Vdc

Pp = 90 mW Max. @ 50 °C ambient temp. lLoap Max = 100 mA

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are
correctly decoded.

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.
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OUTPUT 1 AND 2 CONNECTIONS USING MATRIX 300™ POWER

CAUTION: Power from the Vdc/GND spring clamps is available directly to
the Output Device on the +V/-V spring clamps, and does not pass through

the Power Switch (ON/OFF) inside the CBX. Disconnect the power supply
when working inside the CBX.

Output 1 Device

Power to Output Power to Output
Output device Signal Output device Signal

Output device Output device
Reference Reference
— | | s | s | | | e | | e — — | | o | o |
@/®C|0/C|0[0|0I00 CO@®C00
BV

O1+ 0O1- 02+ O02-| +v 12A 2B -V TX RX
OUTPUTS INPUT2 AUX 3

Output 2 Device

o[l
O[l
o[l

|00

+V -V 01+ O1- 02+ 02-| +v I2A 2B -V
OUTPUTS INPUT2

w

AUX

> RX‘

Figure 53 - PNP/Open Emitter Output Using MATRIX 300™ Power

Output 1 Device

Power to
Output device

Output device
Reference

Output

Output 2 Device

Power to
Output device

Output device
Reference

Output
Signal Signal

9/0/0/0/0/010/00 @6l T)oeee

+V -V 01+ O1- 02+ 02-] +Vv I12A 2B -V
OUTPUTS INPUT2 OUTPUTS

O[l
o[l

™ RX
aux |3

INPUT2 aux |3 ‘

Figure 54 - NPN/Open Collector Output Using MATRIX 300™ Power

> RX‘

OUTPUT 1 AND 2 CONNECTIONS USING EXTERNAL POWER

Output 1 Device

Output 2 Device
Pulled up to External

Pulled up to External
Output Device Power

88¥488888888 8888*%88

+V -V 01+ 0O1- 02+ 02-] +Vv I2A 12B -V TX RX
OUTPUTS INPUT2 AUX 3

o[l
o[l
O[l
o[l

+V -V 01+ 01- 02+ 02-] +Vv I12A 2B -V

T RX
OUTPUTS

INPUT2 aux |3 ‘

Figure 55 - PNP/Output Open Emitter Using External Power

Output 1 Device Output 2 Device
Output

Output
Signal

Signal
Pulled down to External Pulled down to External
Output Device Reference Output Device Reference
| o | s | o || o | | | | o || | | | | o o | o || o | | s

O1+ O1- 02+ 02-| +v I2A 2B -V X RX
OUTPUTS INPUT2 AUX 3

O[l
< O[l

o[l
o[l

+V

+V -V 01+ O1- 02+ 02-] +Vv I12A 2B -V
OUTPUTS INPUT2

™ RX
aux |3

Figure 56 - NPN/Output Open Collector Using External Power
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Output 3 is not opto-isolated but can be assigned to the same events. By default it is not
assigned to any event. The CBX500 must be used to connect this output.

OUTPUT 3 CONNECTIONS USING MATRIX 300™ POWER (CBX500 Only)

Power to X
Output Device Output Device

Output Output Device
Signal Reference

= | | — | | — —l —l

C@R08R®0/0/00

03A 03B +V IBA KA -V 1348 134B|Ss [SGND RTX+ RTx-
OTHER /O % MAIN

Figure 57 - Output 3 Using Matrix 300™ Power

OUTPUT 3 CONNECTIONS USING EXTERNAL POWER (CBX500 Only)

Output

Signal
External Device
Ground Reference

|| — —l | | — o || o | |

e Breeee

03A 03B +V IBA MA -V 134B 134B |8 [SGND RTX+ RTx-
OTHER IO % MAIN

Figure 58 - Output 3 Using External Power

f CAUTION: Do not connect to I3A or 134B signals, they are reserved.
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4.7 ON-BOARD ETHERNET INTERFACE

The on-board Ethernet Interface can be used for TCP/IP communication with a remote or
local host computer by connecting the reader to either a LAN or directly to a host PC. There
is no need to use a crossover adapter since Matrix 300™ incorporates an auto-cross
function.

A CAB-ETH-MOx cable can be used to connect to a LAN.

On the Matrix 300™ Ethernet interface the following communication channels are available:
e Data Socket
e Image Socket
e WebSentinel Socket
e Image FTP Client
e HTTP Server
e EtherNet/IP
e Profinet IO
e Modbus TCP

For further details refer to the Ethernet Folder in the VisiSet™ Help On Line and to the
"Matrix Ethernet Service Guide.pdf* document provided as supplementary documentation.

4.8 USER INTERFACE - SERIAL HOST

The following table contains the pinout for standard RS232 PC Host interface. For other user
interface types please refer to their own manual.

RS232 PC-side connections

1 5 1 13
o000 06O0OGOOOSIOGONOSOSOS

000060606 OCGCOGEOSIOSIOSS

6 9 14 25

9-pin male connector 25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 X 2 X
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS
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5 TYPICAL LAYOUTS

The following typical layouts refer to system hardware configurations. However, they also
require the correct setup of the software configuration parameters. Dotted lines in the figures
refer to optional hardware configurations within the particular layout.

5.1 POINT-TO-POINT

In this layout the data is transmitted to the Host on the main serial interface. The RS232
auxiliary interface can be used for reader configuration by connecting a laptop computer
running VisiSet™. Host Mode programming can be accomplished either through the main
interface or the Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the main interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its

reading zone.
P Host
G6000 CBX
1] ‘7|:|"

CAB-DSxx

]
I
‘

Matrix 300™
@

|
| Terminal
|

@D_ @® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
L 1 @ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 59 — Serial Interface Point-to-Point Layout
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In this layout the data is transmitted to the Host on the TCP/IP Ethernet interface (CBX500
with BM200/210 Host Interface Module installed). The RS232 auxiliary interface can be used
for reader configuration by connecting a laptop computer running VisiSet™. Host Mode
programming can be accomplished either through the TCP/IP Ethernet interface or the
Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the TCP/IP Ethernet selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Power
] 0) (© @
CAB-DSXxx -_—0@ § T \ CBX500
Matrix 300™ I . ©
-1 _JI ® BM2x0 TCP/IP Ethernet Interface
| | @ Auxiliary Serial Interface (Local Echo) (RS232)
[ ] @ ® External Trigger (for One Shot or Phase Mode)

Host

Figure 60 — BM200/210 TCP/IP Ethernet Interface Point-to-Point Layout
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In this layout a single reader functions as a Slave node on a Fieldbus network. The data is
transmitted to the Host through an accessory Fieldbus interface board installed inside the
CBX500 connection box.

Reader configuration can be accomplished through the Auxiliary interface using the VisiSet™
configuration program or Host Mode programming.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the Fieldbus interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

Power
O 0) (O @
® ‘ CBX500
CAB-DSxx = °D

®

Matrix 300™

L 1
@ Fieldbus Interface (Profibus, DevicNet, etc.)
@ Auxiliary Serial Interface (Local Echo) (RS232)
Host ® External Trigger (for One Shot or Phase Mode)
ojojojojojojo (-] (-] ojo (] (-]
o |!| |!| |!| |£| |!| |E| |!| |!| |E| o o o

Figure 61 — Fieldbus Interface Point-to-Point Layout
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5.2 ID-NET™ SYNCHRONIZED NETWORK

The ID-NET™ connection is used to collect data from several readers to build a multi-point or
a multi-sided reading system; there can be one master and up to 31 slaves connected
together.

The slave readers are connected together using the ID-NET™ interface. Every slave reader
must have an ID-NET™ address in the range 1-31.

The master reader is also connected to the Host on the RS232/RS485/422 main serial
interface.

For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;
there is a single reading phase and a single message from the master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.

In the Master/Slave Synchronized layout the Master operating mode can only be set to
Phase Mode.

The main, auxiliary, and ID-NET™ interfaces are connected as shown in the following
figures.

© ©

Slave#l |

Slave#n "i@]'@ ©“

et ©),

Power
Host @® Main Serial Interface (RS232 or RS485/422 Full-Duplex)
— @ External Trigger
| ‘ ® ID-NET™ (up to 16 devices - practical limit)
===
=

Figure 62 — ID-NET™ M/S Synchronized Layout

The Master reader can be connected to the CBX series connection box with the advantage
of the Backup and Restore configuration function (CBX + BM100 module).
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If the Backup and Restore function is not required, then a QL300 or QL500 can be used to
connect the master reader.

CAB-AUX03 CAB-AUX03
ID-NET™ QL150
CBL-1480-xx CBL-1480-xx
Slave Nodes
x
X
& CBL-1490
3 ID-NET
n_n' Terminator
o
Master 1 '
The ID-NET network must be terminated through the
pst | 1 internal switch of the CBX500 and inserting an ID-NET
terminator into the last QL in the network.
POWE! r———]
CAB-PW-EXT 2 1 3 Host @ BA600 ID-NET™ Out
@ = | @ BA400 Ext. Power
= S (3 BA500 Trigger
CBX500 @ BA300 Service
Main [, - <
CAB-AUX03
Figure 63 - ID-NET™ Synchronized Layout
Matrix 300™ Master with CBX500 + Matrix 300™ Slaves with QL150
CBL-1496 CAB-AUX03 CAB-AUX03
ID-NET
QL3OO Terminator ID-NET™ QL15O
1

CBL-1480-xx ‘ CBL-1480-xx -
Slave Nodes T

i | Master CBL-1490
= | ID-NET

| Terminator

| ; The ID-NET network must be terminated inserting an

| PS | — ID-NET terminator into the QL300 (Master) and into the

Power e last QL in the network.
—
CAB-PW-EXT
Host
] |
Main Interface
L

Figure 64 - ID-NET™ Synchronized Layout
Matrix 300™ Master with QL300 + Matrix 300™ Slaves with QL150
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

Power //

T © g Egz@m Slave#1

Master

el Lo
g E]
I 2 i

® BM2x0 TCP/IP Ethernet Interface
.l @ External Trigger
| o= - Host ® ID-NET™ (up to 16 devices - practical limit)

Figure 65 — ID-NET™ M/S Synchronized Layout with BM200/210 TCP/IP Ethernet Interface to Host

Alternatively, the Master reader can communicate to the Host as a Slave node on a Fieldbus
network. This requires using an accessory Fieldbus interface board installed inside the
CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of each individual
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming. See par. 2.3.1 for details.

Power //

i

Master

Slave#n "l@l@ Q"

— )

®

Host
@ Fieldbus Interface
ojojojojojojo ) ) ] .
@@ External Trigger (for One Shot or Phase Mode)
H H M H m H H ® ID-NET™ (up to 16 devices - practical limit)
ojojojojojojo o o ojo o o

Figure 66 — ID-NET™ Fieldbus M/S Synchronized Layout
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5.3 ID-NET™ MULTIDATA NETWORK

For a Master/Slave Multidata layout each reader has its own reading phase independent
from the others; each single message is sent from the master reader to the Host computer.

© ®

/ 2
/L
7/
Master Slave#l Slave#n 5
— —_— W
I— - - —D el I— - el
L1 1
Power
Host @ Main Serial Interface (RS232 or RS485/422 Full-Duplex)

- @ Auxiliary Serial Interface (Local Echo) (RS232)
- ® External Trigger (for One Shot or Phase Mode)
@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 67 — ID-NET™ M/S Multidata

NOTE: The auxiliary serial interface of the slave readers can be used in
Local Echo communication mode to control any single reader (visualize
collected data) or to configure it using the VisiSet™ utility.

The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

Power

CBX500

| — ! Host
|

@ BM2x0 TCP/IP Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 68 — ID-NET™ M/S Multidata Layout with BM200/210 TCP/IP Ethernet Interface to Host

NOTE: The auxiliary serial interface of the slave readers can be used in
Local Echo communication mode to control any single reader (visualize
collected data) or to configure it using the VisiSet™ utility.

The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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Alternatively, the Master reader can communicate to the Host as a Slave node on a Fieldbus
network. This requires using an accessory Fieldbus interface board installed inside the
CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of each individual
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming. See par. 2.3.1 for details.

Power

Master [H® IC e°

@ Fieldbus Interface

Host @ Auxiliary Serial Interface (Local Echo) (RS$232)
ofo[ojo]ofo]o Ol © olo Jo o (3 External Trigger (for One Shot or Phase Mode)
|i| |{| |i| H |i| |}| |i| |i| |{| @ ID-NET™ (up to 32 devices, max network extension of 1000 m)
ojojojojojojo o o o]0 o [

Figure 69 — ID-NET™ Fieldbus M/S Multidata
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5.4 PASS-THROUGH

An alternative Pass-Through layout allows the more efficient ID-NET™ network to be used.
This layout is really an ID-NET Master/Slave Multidata layout which also allows each reader
(Master and Slaves) to accept input on the Auxiliary interface, for example to connect a
device such as a hand-held reader for manual code reading capability.

Each Matrix 300™ transmits its own messages plus any messages received by its Auxiliary
interface onto the ID-NET™ interface. The Master passes all messages to the Host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

® @ / L

Slave#l

Master

Power

Host

@ Main Serial Interface (RS232 or RS485/422 Full-Duplex)
@ Auxiliary Serial Interface (RS232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™

Figure 70 — Pass-Through On ID-NET™ Layout

NOTE: The reading device connected to the Host can be connected to a
Fieldbus network using a Host Interface module through a CBX500

connection box.
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5.5 ETHERNET CONNECTION

The Ethernet connection is possible in two different layouts. In both layouts, before
proceeding with the connection, it is necessary to configure the reader Ethernet parameters
via VisiSet™. For further details, see the Ethernet Folder in the VisiSet™ Help On Line.

In a Point-to-Point layout the reader is connected to a local host by using a CAB-ETH-MOx
cable. There is no need to use a crossover adapter since Matrix 300™ incorporates an
autocross function.

CAB-ETH-MOx ’
® -
il ¢ == 1‘
|
CBX
CAB-DSxx
/I TR
PG6000
[ ] @ @ @ Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Figure 71 - Ethernet Point-to-Point Layout
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When using a Local Area Network (LAN), one or more Matrix 300s can be connected to the
network by using CAB-ETH-MOx cables:

¥ |

BEALANDEIE DEAEANDEIT Matrix 300™ HEGALTEIT
3
=
I
e I I e o]
— @ — —
| O I I
| ! !
| 1 1
- (@ P e Pl 4
=04 ® =09
. .
L :@
Power
Host
NETWORK

@ Ethernet Interface

@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

Ll
Ecﬁmm@t@
R ——

Figure 72 - Ethernet Network Layout

-"l Matrix 300™

X

o

=

T

'_

w

o0

s|

PoE Switch

Ethernet Interface

Figure 73 - POE Ethernet Network Layout

L
Emm@t@
I
9

i

Host
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6 READING FEATURES

6.1 FOV CALCULATION

Referring to Figure 74 and the formula below, use the data in the following table to calculate
the FOV for your application.

Viewing Angle | Viewing Angle | Viewing Angle | Min Reading Distance
Model Lens do Horizontal Vertical Diagonal mm
Matrix 300 4x2-0Oxx | 9 mm liquid 14 mm 40° 32° 50° 22
Matrix 300 4x1-Oxx | 6 mm fixed 7 mm 66° 55° 80° 35

The viewing angle has a tolerance of + 1° depending on the reading distance.

where:

FOV, = 2 Ed + dy) tan (ax/z)]

FOV, = horizontal, vertical or diagonal FOV

oy = horizontal, vertical or diagonal viewing angles.

d = reading distance (from window surface to code surface)

d, = reading distance offset (from center of lens to window surface)

A
o
\i

Example:

FOV
plane

Figure 74 — Reading Distance References

The FOV for a Matrix 300 412-Oxx at a reading distance of 200 mm is:

FOVy =2 [(200 mm + 14 mm) tan (40°/2)] = 156 mm
FOVy =2 [(200 mm + 14 mm) tan (32°/2)] = 123 mm

NOTE: The following diagrams are given for typical performance at 25°C
using high quality grade A symbols according to ISO/IEC 15416 (1D code)
and ISO/IEC 15415 (2D code) print quality test specifications. Testing should
be performed with actual application codes in order to maximize the
application performance.
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6.1.1 Matrix 300 4x1 6 mm Fixed Lens Global FOV Diagrams

The following diagrams show the maximum obtainable Field of View for 1D and 2D codes
using Processing Mode = Advanced Code Setting. Depending on the code resolution,
symbology, and number of characters in the code, the Reading Area can be different
from the FOV. See the reference Reading Diagrams in par. 6.3 for reading area examples.

1D Code FOV

WOT—T———T T T T T T T T T T T T

] i Zd
- B e

10

4 100 +

50 T
10 mils 15 mils

1l : .
a'- 5 mils 12 mils 20 mils
i

-2 50 +

Horizontal FOV

-4 -100 +
-6 150 + \\
8 200 f \
10 250 T T T T T T
0 50 100 150 200 250 300 350 400
mm
in 0 2 4 6 8 10 12 14 16
Distance
2D Code FOV
8 200 i i i

6 150 /
/
4 100 /

10 mils 20 mils

7.5 mils 15 mils 24 mils

Horizontal FOV

-4 -100 + \
-6 -150 \

-200

0 50 100 150 200 250 300 350
in 0 2 4 6 8 10 12 14

Distance
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6.1.2 Matrix 300 4x2 9 mm Liquid Lens Global FOV Diagrams

The following diagrams show the maximum obtainable Field of View for 1D and 2D codes

using Processing Mode = Advanced Code Setting. Depending on the code resolution,
symbology, and number of characters in the code, the Reading Area can be different
from the FOV. See the reference Reading Diagrams in par. 6.4 for reading area examples.

Horizontal FOV

Horizontal FOV

10

mm

200

150 o

100

50 +

50 4

-100 o

-150 o

-200 +

1D Code FOV
12 mils 15 mils
] 10 mils 13 mils
0 50 1(’)0 1;0 2'30 2;0 3(’)0 3;0 4(‘)0 4;0 5(‘)0 5‘50
0 2 4 6 8 10 12 14 16 18 20 22
Distance
2D Code FOV

140 4

120

100 1
}

80 1

140 +

\

/

5 mils 7.5 mils 10 mils

il

T

15 mils

o

0

20 a0
1 2 3 4 5 6 7 8 9 10

Distance

11

&0 80 100 120 140 160 180 200 220 240 260 250 300 320 340

12 13
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6.2 READING DIAGRAMS

e The following reading diagrams are to be considered as references and are given for
typical performance at 25°C using high quality grade A symbols: Code 128 (1D code) and
Data Matrix ECC 200 (2D code) from the Test Charts provided with the reader.

e Testing should be performed with the actual Matrix 300™ using application codes in
order to evaluate whether maximizing application performance requires adjustments to
the HW/SW configuration with respect to the Reference Conditions given under each
diagram.

e The ratio of the Vertical FOV width with respect to the Horizontal FOV width in the
diagrams is about equal to 0.8; specifically 1024/1280. (i.e. FOVy. = FOVy x 0.8).

e The reading distance ranges are measured from the reading window surface.

e The max theoretical Line Speed values for each diagram can be calculated using the
formula in par. 6.5.

¢ Common software parameter settings for all 6 mm models reading all code symbologies,
and all 9 mm models reading 1D code symbologies are: Processing Mode=Advanced
Code Setting; Self Tuning=Disabled.
For 9 mm models reading 2D code symbologies: Processing Mode=Standard; Self
Tuning=Enabled; Self Tuning Mode=Processing Modes Only.

e When defining a HW/SW configuration for the Matrix 300™ for conditions different from
those of the reference diagrams, it is suggested to keep in mind the following rules:

¢ Changes in Exposure Time act directly proportional to the luminosity of the image
and inversely proportional to the maximum code reading movement speed.
Consequently, reducing the Exposure Time by half, reduces the luminosity of the
image by half but doubles the theoretical code reading movement speed.

¢ Changes in Gain act directly proportional to the luminosity of the image.
Increasing the Gain value however, can reduce the quality of the acquired image.

¢ At the center of the field of view, the lighting power of the “RED WIDE” illuminator
is about equal to twice that of the “WHITE WIDE” illuminator, 1.5 times that of the
“MLT-DPM” illuminator, and 2.9 times that of the “LT-DPM” illuminator.

¢ For the two DPM illuminators, the overall lighting power being considered is from
the four Central LED chains, unless specified otherwise.

6.2.1 Pre-Configured .INI Files

Each depth of field (DOF) range shown in the various Reading Diagrams can be obtained by
loading a pre-configured .ini file that already contains the parameter settings necessary to
replicate the reading diagram results.

These .ini files are provided with and can be loaded from the VisiSet™ installation directory
as in the following example:

C:\Program Files\Datalogic\VisiSet2\Std_660\Reading Diagram Configuration Files\412-xxx RED Wide

The names of the .ini files correspond to the specific Reading Diagrams; they indicate the
Code Type, Code Resolution, Reading Distance, and Luminosity variable settings (A or B if
any). These can be directly matched to the relative Reading Diagram to obtain the desired
DOF.
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6.3 MATRIX 300 4X1 (6 MM MODELYS)

6.3.1 1D (Linear) Codes

Horizontal Reading Width

15

-1.5

Code 128 0.12 mm (5 mils)

60 -
— Focusing Distance 70 mm

" /\
40 -

30 +

10 +

-10 4

-20 4

-30 4

45 55 65 75 85
2 25 3 35

Reading Distance

CONDITIONS:

Hardware Settings

Code Symbology Code 128
Code Resolution 0.12 mm (5 mils)
Tilt Angle 0°

Skew Angle 15°
Focusing Distance (mm) 70
Software Parameters

411-xxx RED Wide

Exposure Time (us) 90

Gain 5
llluminator Lighting Mode Very High Power Strobed
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Code 128 0.25 mm (10 mils)

120
. | —— Focusing Distance 130 mml
100 A
3 el /\
60
< 2
o 40 -
; 1
? 20 A
=
I
o) 0 0
@
f_E 20 -
s =
N
= 40 1
o
I -2
-60 .
- \/
4 100 1
-120 T T T T T T T T T
90 110 130 150 170 190
mm
in 4 5 6 7 8
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.25 mm (10 mils)
Tilt Angle 0°
Skew Angle 15°
Focusing Distance (mm) 130
Software Parameters
411-xxx RED Wide
Exposure Time (us) 80
Gain 20

llluminator Lighting Mode

Very High Power Strobed
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Horizontal Reading Width

Code 128 0.30 mm (12 mils)

| - Focusing Distance 160 mm |

Sfzseacts

70 A

50 4

30 A

10 A

-30

-50 4

-70 4

-90 1

-110 A

130 /T T T

o 100 120 140 160 180 200 220 240
in 4 5 6 7 8 9
Reading Distance

CONDITIONS:

Hardware Settings

Code Symbology Code 128
Code Resolution 0.30 mm (12 mils)
Tilt Angle 0°

Skew Angle 15°
Focusing Distance (mm) 160
Software Parameters

411-xxx RED Wide

Exposure Time (us) 100

Gain 20
llluminator Lighting Mode Very High Power Strobed
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Horizontal Reading Width

CONDITIONS:

Code 128 0.33 mm (13 mils)

160 +—

140

120

100

80

60

40

20

-100

-120

-140

-160

~— Focusing Distance 150 mm [ 77 —
- Focusing Distance 185 mm

iz ai

N

—T T T T T T T T T T T T T T

70 90 110 130 150 170 190 210 230 250 270

5 6 7 8 9 10

Reading Distance

Hardware Settings

Code Symbology Code 128
Code Resolution 0.33 mm (13 mils)
Tilt Angle 0°
Skew Angle 15°
Focusing Distance (mm) 150 | 185
Software Parameters
411-xxx RED Wide
Exposure Time (us) 150 175
Gain 13 20

llluminator Lighting Mode

Very High Power Strobed
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Code 128 0.38 mm (15 mils)

160 -{ —Focusing Distance 200 mm
6 1| =———Focusing Distance 220 mm
140
° 120
4 100
3 e /
=
5 60
= 2
= 40
o
£ ! 20
-
I
O 0 0
o
g 4
c
) -40
N
= 2
() -60
I
c o \
-4 -100
5 120
-140
-6
‘160 T T T T T T T T T T T T T T T T T T T T
MM g0 100 120 140 160 180 200 220 240 260 280
in 3 4 5 6 7 8 9 10 11
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.38 mm (15 mils)
Tilt Angle 0°
Skew Angle 15°
Focusing Distance (mm) 200 | 220
Software Parameters
411-xxx RED Wide
Exposure Time (us) 250 250
Gain 6 15

llluminator Lighting Mode

Very High Power Strobed
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Code 128 0.50 mm (20 mils)

~——Focusing Distance 270 mm
———Focusing Distance 290 mm
8 200
] = //Q
= 4 100 A
2
=
o 2 50
=
o
I
o) 0 0 -
@
©
< 2 50 -
o
N
% -4 -100 -
= S \\O
-8 -200 A
'250 T T T T T T T T
mm 150 200 250 300 350 400
in 6 8 10 12 14 16
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.50 mm (20 mils)
Tilt Angle 0°
Skew Angle 15°
Focusing Distance (mm) 270 | 290

Software Parameters

411-xxx RED Wide
Exposure Time (us) 330 330
Gain 23 25
llluminator Lighting Mode Very High Power Strobed
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6.3.2 2D (Bi-dimensional) Codes

Data Matrix 0.19 mm (7.5 mils)

2 50 - Zixas &3 Horizontal
= Focusing Distance 60 mm Reading Width . .
7 Reading Distance
15 401
30 4 Max FOVy
1 ?
% 20 A T~ 406 +15
s -
(@)} 10 - ! 0.6 15
c s
o in mm
8 o o
o |
s
c -10 A
QP Due to the “fisheye" effect of the wide angle
5 20 | 6 mm lens, the reading area for higher
T resolution codes is limited to the central zone
t of the Vertical Field of View.
-30 4 t
For these applications, window cropping is
15 a0 4t recommended above and below the central
| / zone of the Vertical FOV, limiting image
acquisition to the effective reading area and
2 =5 % : 4‘0 y o e;o ’ 70 therefore increasing frame rate and reducing
mm overall image processing time. See par. 7.5.8.
n 15 2 25 *+ 15 mm = 550 pixels
Reading Distance Region of Interest Top = 236
Region of Interest Bottom = 786
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.19 mm (7.5 mils)
Tilt Angle 45°
Skew Angle 0°
Focusing Distance (mm) 60
Software Parameters
481-xxx MLT-DPM
LED Chain Type Peripheral
Exposure Time (us) 380
Gain 23

llluminator Lighting Mode

Very High Power Strobed
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Data Matrix 0.25 mm (10 mils)

70 -| = Focusing Distance 85 mm Horizontal
Reading Width . .
25 Reading Distance
60
2 50 -
15 40 : Max FOV,,
< 30 ~ +0.8  +20
o 1 _
; 20 -
2 s 1 08 -20
= 10 -
o 4 in mm
]
Q 0 0 -
4 |
® -10 -
S T
N 2L Due to the “fisheye" effect of the wide angle
s o 6 mm lens, the reading area for higher
L I resolution codes is limited to the central zone
15 40 4 of the Vertical Field of View.
2 50 For these applications, window cropping is
i recommended above and below the central
25 207 zone of the Vertical FOV, limiting image
pow I ' acquisition to the effective reading area and
60 70 80 00 iod 110 therefore increasing frame rate and reducing
mm overall image processing time. See par. 7.5.8.
" 25 : 5 4 + 20 mm = 512 pixels
Reading Distance Region of Interest Top = 255
Region of Interest Bottom = 767
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.25 mm (10 mils)
Tilt Angle 45°
Skew Angle 10°
Focusing Distance (mm) 85
Software Parameters
411-xxx RED Wide
Exposure Time (us) 170
Gain 4

llluminator Lighting Mode

Very High Power Strobed

481-xxx MLT-DPM

Exposure Time (us)

170

Gain

6

llluminator Lighting Mode

Very High Power Strobed
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Data Matrix 0.38 mm (15 mils)

80

~—Focusing Distance 30 mm |

3 4
70
60
2 50
40 A
o J
—
© 30
: ]
20
o 4
ie}
< 4
Q 0 0
@ 1
o -10
- -
c
(@) -20
N 1
— -
o -30
T 4
-40
2 50 A
-60 -
-70 4
-3 -
-80
50
mm
in 2

CONDITIONS:

60 70 80 S0 100 110 120 130 140

3 4 5 6

Reading Distance

Hardware Settings

Code Symbology

Data Matrix ECC 200

Code Resolution

0.38 mm (15 mils)

Tilt Angle 45°
Skew Angle 10°
Focusing Distance (mm) 90
Software Parameters

411-xxx RED Wide
Exposure Time (us) 80
Gain 8

llluminator Lighting Mode

Very High Power Strobed

481-xxx MLT-DPM

Exposure Time (us)

80

Gain

12

llluminator Lighting Mode

Very High Power Strobed
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6.4 MATRIX 300 4X2 (9 MM MODELS)

6.4.1 1D (Linear) Codes

Code 128 0.25 mm (10 mils)

150
— - - Global Reading Area
= Reading Distance = 190 mm =
e Read. Dist. = 300 mm, A
4 100 ——— Read. Dist. = 300 mm, B
2 2 50 |
= ] et
o _ -
c R
k=l | A
5 10
g 0 o1
(_G - k e
c | . 5
(@] .
N 1 N
‘T -2 -50 - e
)
I : \\&
-4 -100 1 \K/
] I
~.
_6-150'"‘I""I""I""I"“I' S L T
mm 0 50 100 150 200 250 300 350 400
in 0 2 4 6 8 10 12 14
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.25 mm (10 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 190 300 300
412-xxx RED Wide A B
Exposure Time (us) 130 230 500
Gain 25 25 25

llluminator Lighting Mode

Very High Power Strobed

93



MATRIX 300™ REFERENCE MANUAL

Code 128 0.30 mm (12 mils)

200
] — - - Global Reading Area
T = Reading Distance = 190 mm
6 450 A «w Read. Dist. = 360 mm, A LL
1| = Read. Dist. = 360 mm, B =1l
4 100 1
E .
= | /‘
2
i 50 - P
c e /'/
S ] o
S o 1
x 0 ] k
© 1 .
1= 1 BnE
o . ~ .
N 2 .50 A 5
o i \
I i \&
4 -100 4
i i I
. ~. .
6 -150 3 >
-200 LU R B EENL N N B I NI B B B IR B B B S B R L L LI B (NN B N B B (R S B B B B BB B
mm 50 100 150 200 250 300 350 400 450
in 2 4 6 8 10 12 14 16
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.30 mm (12 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 190 360 360
412-xxx RED Wide A B
Exposure Time (s) 150 230 500
Gain 20 25 25
llluminator Lighting Mode Very High Power Strobed
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Code 128 0.33 mm (13 mils)

8 200
] — - - Global Reading Area
] Reading Distance = 185 mm e
6 150 - Read. Dist. = 395 mm, A U
B Read. Dist. =395 mm, B
4 100 A /
= i
§ ] /
= 2 50 =
o i N o
c ] Tt
5 : -
o 0 R
04 1+
T I ERENCAE
c - ~
8 7 % \\
o g
T i
-4 -100 A x
-6 -150 - =
1 ~I
8 200 ++——TTTTTT T T T T T T T T T T T T T T T T T T T
mm 0 50 100 150 200 250 300 350 400 450 500
in 0 2 4 6 8 10 12 14 16 18
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.33 mm (13 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 185 395 395
412-xxx RED Wide A B
Exposure Time (us) 150 300 3300
Gain 25 25 15
llluminator Lighting Mode Very High Power Strobed High Power Strobed
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Code 128 0.38 mm (15 mils)

10 250 -
5 — - - Global Reading Area
8 200 1 —— Reading Distance = 180 mm
i e Read. Dist. = 452 mm, A |
] ——— Read. Dist. = 452 mm, B .
6 150 .
4 100 E /
< 2 50
5 ] -
2 TILErT
o 0 0 5
= ]~
1 ~
] ] et
Q -50
@ -2 50
®© ]
S -4 -100 -
N ]
S :
T -150 -
5 'q
-8 =200 -
-10 -250 -""l""l""l""l'"'I""l""l""l""l""l""
mm  © 50 100 150 200 250 300 350 400 450 500 550
in 2 4 6 8 10 12 14 16 18 20
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Code 128
Code Resolution 0.38 mm (15 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 180 452 452
412-xxx RED Wide A B
Exposure Time (us) 140 320 3300
Gain 25 25 15
llluminator Lighting Mode Very High Power Strobed High Power Strobed
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6.4.2 2D (Bi-dimensional) Codes

Data Matrix 0.13 mm (5 mils)

55
2 i
Gk — - - Global Reading Area
== Reading Distance =75 mm
1.5 - w—= Reading Distance =83 mm (‘
| = Reading Distance =92 mm . //(
-
1 25 - gt
- / - / :
) .
k=) 05 AP 1
= ‘ |
g 3 |
?? 0 e 1
x s |
[ I I
= -0.5
g -15 4 e~
N 4 oy ~
2 1 =25 e
- ) \ .
-35 A i
-15 i d
-45 -
2 §
-55 T T T T T T T T T T T T T T T T
mm 0 10 20 30 40 60 70 20 S0 100 110
in 0 0.5 1 15 2.5 3 3.5 4
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.13 mm (5 mils)
Tilt Angle 45°
Skew Angle 20°
Software Parameters
Reading Distance (mm) 75 83 92
412-xxx RED Wide
Exposure Time (us) 60 80 100
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
472-xxx LT-DPM
Exposure Time (us) 175 235 290
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
482-xxx MLT-DPM
Exposure Time (us) 90 120 150
Gain 15 12 10
llluminator Lighting Mode Very High Power Strobed
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Data Matrix 0.19 mm (7.5 mils)

80
3 4
Bl Global Reading Area
| | == Reading Distance = 85 mm
60 | | = Reading Distance =110 mm =
2 sg J | = Reading Distance =145 mm |
a0 |
E a /
- 30 - —
- — 1 n - / =
i 20 - NP L
[ T l 4=
5 10
8 i
nd 0 0 - I
g -10 |
o 1 i
N -20 - z ,
6 -1 = ~ I
= Sl ‘\\
40 K
> 50 - |
B iy
-70 - )
3 g .
-80 T T T T v T L} T Al T 1} T . T L} T Lt T ! T 1) T L] T T T L) 1
mm O 10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170
in 1 2 3 4 5 6
Reading Distance
CONDITIONS:

Hardware Settings

Code Symbology

Data Matrix ECC 200

Code Resolution

0.19 mm (7.5 mils)

Tilt Angle 45°

Skew Angle 15°

Software Parameters

Reading Distance (mm) 85 110 145
412-xxx RED Wide

Exposure Time (us) 85 110 150

Gain 12 12 12

llluminator Lighting Mode

Very High Power Strobed

472-xxX LT-DPM

Exposure Time (us)

247 310 435

Gain

12 12 12

llluminator Lighting Mode

Very High Power Strobed

482-xxx MLT-DPM

Exposure Time (s)

128 165 225

Gain

12 12 12

llluminator Lighting Mode

Very High Power Strobed
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Data Matrix 0.25 mm (10 mils)
4 100
1 [ —-- Global Reading Area
80 | | = Reading Distance =100 mm i
-t
3 1| == Reading Distance =135 mm S|
60 1L — Reading Distance =195 mm |
i ] /
e 40
§ 1 " /
; 1 ] o T
o 20 + =
= ] )
U -1 .
8 o o]
nd i
£ ] nt
S -20 - ~e
N -l 1 b
= 7 T
o -4
I -40 - \
_2 _ &
-60 - |
i ] A
3 g0 ] = 3
'4-100 LI S P B L Y N DY S (YL S P NS S PR N T D S DY R AR B G DR S TR R DAL S | 1
mm 0 20 40 60 80 100 120 140 160 180 200 220
in 0 1 2 3 4 5 6 7 8
Reading Distance
CONDITIONS:
Hardware Settings
Code Symbology Data Matrix ECC 200
Code Resolution 0.25 mm (10 mils)
Tilt Angle 45°
Skew Angle 15°
Software Parameters
Reading Distance (mm) 100 135 195
412-xxx RED Wide
Exposure Time (ps) 100 160 200
Gain 13 13 19
llluminator Lighting Mode Very High Power Strobed
472-xxx LT-DPM
Exposure Time (us) 290 465 500
Gain 13 13 22
llluminator Lighting Mode Very High Power Strobed
482-xxx MLT-DPM
Exposure Time (us) 150 240 300
Gain 13 13 19
llluminator Lighting Mode Very High Power Strobed
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Data Matrix 0.38 mm (15 mils)

150

5 130 — - - Global Reading Area

= Reading Distance =130 mm

110 = Reading Distance = 195 mm

90 ]| = Reading Distance =300 mm

70

e

30

Horizontal Reading Width

-110
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Reading Distance

CONDITIONS:

r——
20 40 60 80 100 120 140 160 180 200 220 240 260 280 300 320 340

11

T

12

T T T

13

T

Hardware Settings

Code Symbology

Data Matrix ECC 200

Code Resolution

0.38 mm (15 mils)

Tilt Angle

45°

Skew Angle

15°

Software Parameters

Reading Distance (mm) 130

195

300

412-xxx RED Wide

Exposure Time (us) 250

250

380

Gain 8

17

22

llluminator Lighting Mode

Very High Power Strobed
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6.5 MAXIMUM LINE SPEED AND EXPOSURE TIME CALCULATIONS

The Exposure Time (or Shutter) parameter defines the time during which the image will be
exposed to the reader sensor to be acquired. This parameter depends heavily on the
environmental conditions (external lighting system, image contrast etc.).

In general, a longer time corresponds to a lighter image but is susceptible to blurring due to
the code movement; a shorter exposure time corresponds to a darker image.

NOTE: The following considerations must be applied only when the internal
lighting system and 2D codes are used. The Maximum line speed allowed for
linear codes or postal code reading applications heavily depends on the

direction of symbol movement. When the direction of movement is parallel to
the elements of the code, the maximum speed is greater.

Assuming:
¢ X: Code Resolution (mm)
e Texp: Exposure Time (s)

e LS: Line Speed (mm/s)

The essential condition to avoid blurring effects between two adjacent elements in a dynamic
reading application is:

LS * Texp < X

The maximum (theoretical) line speed LS can be calculated as follows:
X / Texp (max) =LS (max)
Example:

A Matrix 300™ using:

Internal Lighting Mode = Very High Power Strobe
Exposure Time (x1 xs) = 100 (100 us)
Code Resolution (X) = 0.254 mm (10 mils)

has a maximum line speed of:

0.254 (mm) / 0.0001 (s) = 2540 mm/s

Likewise, Texp (max) IS the maximum Exposure Time value that can be used without blurring
for the given application line speed and code resolution. Therefore:

X/ LS (max) = Texp (max)
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Texp max) @nd LS max) are represented in the graph below as the curved line for X (code
resolution). Values above the curve result in blurring. In practice, the application values are
somewhere below the theoretical line, (in the green area), due to environmental and other
conditions.

1
. 5
SW Limit g -
o
% =
S €
Py
@ 0
|_ 1
1
1
|
|
Texp (min) .
SW/HW Limit Line Speed
El Readable [ Blurring

For example, the maximum target speed in the application is also affected by these
conditions:

e Code/Background Contrast: maximum speed decreases when decreasing image
contrast (poor quality codes, reflective transparent coverings, different supports and
printing techniques).

e Code Resolution: maximum speed increases when decreasing code resolution, (i.e. 2X).
There is a decrement of overlapping effects between two adjacent elements.

¢ Tilt Angle: maximum speed decreases when increasing Tilt angle (from 0 to 45 degrees).

Texp (min) IS the minimum Exposure Time value obtainable for the specific application. It can
be evaluated in static reading conditions and depends on the Matrix reader hardware
selected for the application (internal lighting system, optical lens, reading distance) and on
any external lighting system. It may also depend on code printing quality, and reader
position.

The Internal Lighting Mode parameter allows setting the operating mode of the internal
lighting system. The possible values are:

e Disabled: the built-in LED array is turned off all the time. This option can be useful if using
an external lighting system;

e Always ON: the built-in LED array is turned on all the time at the lowest power level. This
option is useful if the LED-array blinking (Strobed operating mode) disturbs the operator.

e Very High/High-Power Strobed: the built-in LED array is on only during the image
exposure time. Two different lighting levels can be set.

NOTE: To avoid LED array overheating, for Power Strobed settings, the
program automatically limits the range of allowed values for the Exposure
Time parameter. Therefore, after changes to Internal Lighting Mode, recheck
Exposure Time.
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7/ SOFTWARE CONFIGURATION

Software configuration of your Matrix 300™ for static reading or simple code reading
applications can be accomplished by the Rapid Configuration procedure using the
X-PRESS™ HMI (which requires no external configuration program) or by using the
VisiSet™ Setup Wizard for easy setup. These procedures are described in chapter 1.

For other applications use VisiSet™, connecting to the reader through one of the serial ports.

NOTE: For Ethernet applications, connections to VisiSet™ can be made
directly through the Ethernet port of the reader, or QL500 or BM2x0 Host
Interface module. See the "Configuration Through Ethernet" page in the

VisiSet™ Help On-Line, or the "Matrix Family Setup Procedure Using
Programming Barcodes" document on the Mini-DVD.

7.1 VISISET™ SYSTEM REQUIREMENTS

To install and run VisiSet™ you should have a Laptop or PC that meets or exceeds the
following:

¢ Pentium processor

e Windows: 98/2000, NT 4.0, XP, Vista, 7 or 8

e 32 MBRam

e 5 MB free HD space

o one free RS232 serial port with 115 Kbaud (or USB-Serial adapter)

e one Ethernet TCP/IP port

¢ Video Adapter (1024 x 768) or better using more than 256 colors

7.2 INSTALLING VISISET™

To install VisiSet™, proceed as follows:

1. Turn on the Laptop or PC that will be used for configuration (connected to the Matrix
300™ communication ports).

2. After Windows finishes booting, insert the Mini-DVD provided.
Launch VisiSet™ installation by clicking Install.

Follow the instructions in the installation procedure.

103



o MATRIX 300™ REFERENCE MANUAL

7.3 STARTUP

After completing the mechanical and electrical connections to Matrix 300™, you can begin
software configuration as follows:

1. Power on the Matrix 300™ reader. Wait for the reader startup. The system bootstrap
requires a few seconds to be completed. The reader automatically enters Run Mode.

Run the VisiSet™ program.

Press Connect on the VisiSet™ menu bar. The PC will automatically connect to the
Matrix 300™ reader.

Upon connection, Matrix 300™ exits Run Mode and displays the Main Menu on VisiSet™
with all the commands necessary to monitor your reader's performance. You can select
these commands using the mouse or by pressing the key corresponding to the letter
shown on the button. See Figure 75.

& visiset
Fle Edk Connect Disconnect Devie Options Tools Help Menu Bar

MAIN MENU
Device: Matrix 300

M. Setup Wizard Model: 412-010
Communication Port: Ethernet

F. Calibration Tool
Standard Application Program for Matrix Family Rel. 6.60

]. Data Matrix Setup Wizard MACNUM: 00:07:BE:00:99:A2
DHCP disabled.

A. Run Mode IP Address: 172.27.101.151
Subnet Mask: 255.255.0.0
B. Capture Image Gateway: 172.27.2.254
DNS1: 172.27.0.32

C. Decode Last Image
D. View Last Image

E. Download Last Image
H. Upload Bitmap Image
Q. Image Buffer

3. Button Function Menu ;
Terminal

Window

Status Bar
Command
Window

Connection; B13P00018 on 172.27.101.151 Reader Status: OFF LINE MODE Log : OFF

Figure 75 - Main Window
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7.3.1 VisiSet™ Options

The Options item from the VisiSet™ menu (see Figure 75) presents a window allowing you
to configure:

— the logging function (Log)
— VisiSet™ window properties (Environment)

— VisiSet™ communication channel (Communication)

& visiset Options @]

Save Exit

Log I Environmenl] Communication I

Log options
Log File Name
I.\Iog.bcl Browse
Default Open State Delete old log file
« OFF " ON « OFF " ON

Log Print Level
& Evenything

" Only Codes

" Only Errors

Exit

Figure 76 - Options - Log

& visiset Options @

Save Exit

Log  Enviranment | Communication |

Font & Background

Text example

Change Fant

Restore Factory Settings

Change Background

Save Exit

Figure 77 - Options - Environment
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Save Exit

Log |Envircmmem Communicationl

Communication Channel
« Serial port " USB

Autoconnect ports Starting port configuration for auto search

Port Baud rate (bps) Stop hits
IZQJCoM! :J'  COM1 2400 «1
v |COM2Z ~ C COM2 4800 2
[~ |COM3 ~
& 9600
[~ |COM4 ~ .
@ 19200 Parity
& None
" 38400
57600 e
+ 115200  Odd

B} VisiSet Options @

" Ethernet

Exit

Figure 78 - Options — Communication: Serial Port

Save Exit

Log |Envir0nment Communi:aﬁionl

Communication Channel
" Serial port " USB

Device Ethemet Channel Address

IP Address 172.16.11.12

IP Port Number ] File IP Port Number .

Stop Device Network Searching l

& Ethernet

Device ID IP Address |MAC Number S
MATRIN 172161112 0007BE004389 =
MATRIX 72181118 0007b2003(cd
MATRIX 172161116 0007BE0D3EIC
MATRIX 1721611171 0007BE0DZDIE

i

Figure 79 - Options — Communication: Ethernet
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7.4 ETHERNET CONFIGURATION (STATIC IP ADDRESSING)

If you want to connect to VisiSet™ using Ethernet then follow the procedure below.

In order to find the reader using the VisiSet™ Look For Devices On Network tool, the
reader and VisiSet™ must be on the same network (not through a sub-network or
router).

The Factory Default static IP address parameter settings for all Matrix Family readers are:

e |P Address =172.24.24.1
e Subnet Mask = 255.255.0.0
e Gateway Address = 172.24.255.254

1. Before changing the Ethernet network settings
on the PC running VisiSet™, close any open
applications which use network resources (i.e. — —

You can get [P settings assigned automatically if your network supports
OUtIOOk, or Web brOWSEr) this capability. Otherwise, you need to ask your network administrator for

the appropriate IP settings.

Internet Protocol (TCP/IP) Properties @@

General

2. On the Configuration PC, from the Control 5iDbtonn Fusdoss kool
Panel> Network Connections, right-click on the O e P 172 24 255 254
LAN connection icon and open the properties i 255.255.0.0
window. S 172 .24 . 255 . 254

3. Select the Internet Protocol (TCP/IP) item and
open the properties window.

(®) Use the following DNS server addresses:
Preferred DNS server:

Altemate DNS server:

4. Set the IP Address fields as shown in the figure

and click OK to save.
5. In VisiSet select the Ethernet Communication

Channel in the Options> Communication

window. Then press the Look For Devices On Network button. The Matrix reader will
appear with its default IP Address in the
list.

EE VisiSet Options @

Save Exit

6. Input the IP address from the list in the
IP Address field of the Device Ethernet

Log | Environment Communicatlonl

Communication Channel

Channel Address section of the ¢ Serialport - Use & Ethemet
VisiSet™  Options> Communication Do Ehen e Chom el Adaroas

window (or double-click on the device in Paddess [

the |iSt). The IP pOft number is 51235. IPPotNumber  [F255 FileIPPortNumber [T

Then click Save.

Look For Devices On Network |

7. Perform a Connect (to device) from
VisiSet™.

Device ID IP Address IMAC Nurnber &

Exit
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7.5 CONFIGURATION

Once connected to Matrix 300™ as described in par. 7.3 or 7.4, you can modify the
configuration parameters as follows:

1.

Press the Calibration Tool button from the Main Menu. Matrix 300™ will download its
permanent memory configuration parameters with the default values (if it is the first time)
to VisiSet™. The Calibration Tool window will be displayed together with the Parameter
Setup window working in Interactive Mode (see par. 7.5.1 and par. 7.5.3).

Edit the Matrix 300™ configuration parameters according to your application
requirements.

Use the Calibration Tool to fine tune the reading performance. See par. 7.5.3.

Close the Calibration Tool window and disable the Interactive Mode by pressing the
interactive button.

Save the new configuration to the reader permanent memory by pressing the Send
button.

NOTE: Especially for lengthy configurations in Interactive Mode, it is always
good practice to periodically send the configuration to Permanent Memory to

6.
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avoid losing the configuration in Temporary Memory.

Close the Parameter Setup window and press Disconnect on the VisiSet™ menu bar
(see Figure 75) or launch Run Mode from the VisiSet™ Main menu.

Disconnect exits closing communication between Matrix 300™ and VisiSet™, and
causes Matrix 300™ to enter Run Mode. The disconnected reader serial port is now
available.

Run command does not close communication between Matrix 300™ and VisiSet™,
and causes Matrix 300™ to enter Run Mode. In this case the reader output messages
are displayed on the VisiSet™ terminal and the statistics are displayed in the
Statistics window (Statistics enabled).
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7.5.1 Edit Reader Parameters

The Parameter Setup window displays the configuration parameters grouped in a series of
folders. Each parameter can be modified by selecting a different item from the prescribed list
in the box, or by typing new values directly into the parameter box.

By right clicking the mouse when positioned over the name of a specific Parameter or Group,
a pop-up menu appears allowing you to directly manage that particular parameter or group.

You can View the Selected Value for each parameter.
You can Restore the Default Value of each parameter or of all the parameters of a group.

Get Properties gives information about the parameter in the form of a pop-up hint that
describes the default value and the range/list of valid values.

The Short Help gives information about the parameter in the form of a pop-up hint.

(H parameter Setup

File Device Mode

Get | Send | SendDefaults | Permanent || [[interactive
2D Codes l 1D Codes ] Postal Codes | Image Processing | Miscellaneous |
Reading System Layout [ Ethernet ] Fieldbus I Display | Diagnostics I
Operating Modes | Cali— EE— — LEDs And Keypad |
Data Collection Match Parameter Group | Communication |

CODE COLLECTION 7
Number Of Codes / 1
Code Collection Filters / Disabled
DATA FORMAT 7
Code Field Justification Disabled
Code Fielfl Cutting Disabled
E Parameter t \}?e‘w Selected Value
i

Statistics Field Separator String

Restore Default Value

Statistics Field Format

Get Properties

Symbology |dentifiers

Short Help

STATISTICS

Status

Disabled

Single group/parameter
management
(right click)

Figure 80 - Editing Parameters
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Parameters to verify/modify:

U Operating Mode Sets the parameters which customize the reader operating mode
starting from three main modes:

One Shot: acquires a single image based on the selected value
for the Acquisition Trigger and Acquisition Trigger Delay.

Continuous: continuously acquires images with a rate up to the
maximum allowable frame rate per second for the given sensor
depending on the decoding time and the Region of Interest
settings.

Phase Mode: acquires images during the reading phase
depending on the selected value for the Acquisition Trigger and
Acquisition Trigger Delay. The Reading Phase-ON and Reading
Phase-OFF events mark respectively the beginning and end of
the reading phase.

U Calibration Calibrates the acquisition parameters to maximize the reading
performance (see par. 7.5.3).

U0 Communication Configures the parameters relative to each serial port regarding
the transmission, message formatting and string receiving.

Any change to the VisiSet™ communication port parameters

(baud rate, data bits, etc.) is effective as soon as the reader is
disconnected from VisiSet™.

U Reading System Layout Allows configuring the device according to the desired layout:
Standalone or ID-NET™

4 WebSentinel Enables the Ethernet WebSentinel Agent for communication with
the Datalogic WebSentinel™ plant array monitor.

O Ethernet Sets the parameters related to the on board Ethernet interface
and to its communication channels. Supports application
protocols: TCP/IP, EtherNet/IP, Profinet IO and Modbus TCP

U CBX Gateway Sets the parameters related to the External Host Interface
Module through the CBX500 and to its communication channels.

U Image Processing Sets the image processing parameters shared by all available
symbologies.

4 1D & 2D, Postal Codes Sets the characteristics of the code symbologies to be read.

U Data Collection Defines the code-collection parameters and the output message
format.

4 Digital /0 Configures the reader input/output parameters.

U Match Code Allows setting a user-defined code and relative parameters to
which the read code will be compared (matched).

U Miscellaneous Sets the reader name and the saved image format.

U Symbol Verification Sets the parameters relative to the various specifications in the
Standards which regulate code validation.

U LEDs And Keypad Sets the X-PRESS™ LED and Keypad parameters related to their

selected Functions: Beeper, Green Spot, Setup, Positioning, etc.

U Display Sets the Display language and Layout of the BM150 Display
when using the CBX500 connection box.

U Diagnostics Enables various diagnostic messages, formatting and actions.
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When all the configuration parameters are set correctly, save them to the Matrix 300™
reader by pressing the Send button. See Figure 80.

For successive configuration of other readers or for backup/archive copies, it is possible to
save the configuration onto your PC by selecting the Save Configuration File option from
the File menu.

From the File menu, you can also Save Configuration As Text File for a human readable
version.

Load Configuration File (available in the File menu) allows you to configure a reader from a
previously saved configuration file (.ini).

7.5.2 Send Configuration Options

The device parameters are divided into two main classes, Configuration and Environmental
which are affected differently by the Send Configuration and Send Default Configuration
commands.

Configuration Parameters regard parameters that are specific to the device. These
parameters are influenced by the Send Configuration and Send Default Configuration
commands, that is, they are overwritten by these commands. The same parameters are
modified by the following "Send Configuration with Options" and "Send Default Configuration
with Options" dialogs from the Device Menu:

H Parameter Setup

File NeEUEEE Mode
Get Configuration i
( nt | Interactive I
~—— Send Configuration >
2D Send Configuration With Options » fing | Miscellaneous |
R | Di ti
DE Send Default Configuration » P E]w [l lagfﬁosr = {
| Send Default Configuration ‘With Options » AN
Op LEDs And Keypad |
OPEl  Select Next Parameter Ctrl+F1
T Select Previous Parameter Ctrl+F2
Reading Phase ON Ext. Trig. Leading Edge
Acquisition Trigger Continuous
Reading Phase OFF Ext. Trig. Trailing Edage
Image Acquisition Buffer Size 2
ACQUISITION TRIGGER DELAY 1
Status Disabled
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Environmental Parameters regard the device Identity and Position in a Network (ID-NET™,
Ethernet, Fieldbus) and are not influenced by the "Send Default Configuration" and "Send
Configuration" commands. This allows individual devices to be configured differently without
affecting their recognized position in the network.

The following is a list of the Environmental Parameters:

READING SYSTEM LAYOUT
- Device Network Setting
- Number of Slaves

DEVICE NETWORK SETTINGS

- Topology Role

- ID-NET Slave Address

- Network Baud Rate

- Acquisition Trigger String  (available only in Multidata configuration)
- Reading Phase ON String  (available only in Multidata configuration)
- Reading Phase OFF String (available only in Multidata configuration)

- Header String (available only in Slave Multidata configuration)
- Terminator String (available only in Slave Multidata configuration)
- Link Failure String (available only in Master Synchronized configuration)

- Link Failure Timeout (ms)  (available only in Master Synchronized configuration)

EXPECTED SLAVE DEVICES
- Status

- Device Description

- Device Network Name

MAIN PORT
- Communication Protocol

ETHERNET SYSTEM (on board)
- Status

- DHCP Client

- |IP Address

- Subnet Mask

- Gateway Address

- DNS1 Address
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HOST INTERFACE
- Host Interface Type

CBX ETHERNET SYSTEM (CBX with Host Interface Modules)

- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

PROFIBUS
- Node Address

DEVICENET
- Node Address

ETHERNET-IP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

PROFINET IO

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

CANOPEN
- Node Address

CC-LINK
- Node Address

MODBUS TCP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

MISCELLANEOUS
- Reader Name

- User Name

- Line Name
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For device replacement it is necessary to send the previously saved configuration (both
Configuration and Environmental parameters) to the new device. To do this select "Send
Configuration with Options" from the Device Menu and check the Environmental Parameters

checkbox:
&t Send Options @

Do you wantto send current configuration to device ?

-Parameter Selection
F

v Environment Parameters:

o Ves I X No

In order to return a device to its absolute default parameters including Environmental
parameters, the following Send Default Configuration with Options" dialog must be used:

(4 Send Defaults Options @

Do you want to restore default configuration to dewvice ?

-Parameter Selection
I"':

v Environment Parameters

o Yes I X No

114



SOFTWARE CONFIGURATION

7.5.3 Calibration

VisiSet™ provides a Calibration Tool to maximize the reading performance by tuning the
acquisition parameters and the time of the delayed triggers.

By selecting the Calibration Tool from the VisiSet™ Main Menu (F), the following window
appears together with the Parameter Setup window:

& calibration Tool
Top,Left

Image Lighting Quality

Image Acquisition Information

Acquisition Setting: 1

Exposure Time [x10us): 35

Gain: 403

Decoding Results

Symbology: Data Matrix ECC 200

Code Data: Datalogic 2D Code Reader
Code Center: [X.Y])1=[811,613)
Code Orientation: 0

Exposure Index: |

Underexposed

J

oK

Statistical information on the last 10 samples

Overexposed

8510

Bottom,Right

Self Tuning:

Selected Code:

Quality Index:

Lighting Index:

TX/RX

Stop Image Acquisition
(" Disabled

(e After Any Capture
" OnNo Decode

(" OnDecode

Screen Mode

(¢ Decoded Image
" Code Position Only
" Camera Mode

Arm Trigager ‘

View Image I

Download Image |

Disabled

=

100%

Figure 81 - Calibration OK

This tool provides a "real-time" image display while Matrix 300™ is reading. It also gives
immediate results on the performance of the installed Matrix 300™ reader.

If Self Tuning is enabled, the Calibration Tool window indicates the region where the

calibration algorithm is performed: it is within the central box delimited by four red dots.

dots delimiting the calibration algorithm area may be located outside the

@ NOTE: If using Region Of Interest windowing, some or all of the four red

VisiSet™ display area (not visible).
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The Parameter Setup window works in Interactive Mode in order to cause each parameter
setting to be immediately effective.

O

NOTE: If you want to save the temporary configuration to permanent
memory, you must first close the Calibration Tool window. Then, you must

disable the Interactive Mode and select the Permanent Memory option from
the Send Configuration item in the Device menu.

The following examples show some of the typical conditions occurring during the installation:

Under-exposure:

To correct this result it is recommended to change the following parameters in their order of

appearance:

1. increase the Exposure Time

2. increase the Gain

G

NOTE: In general, a longer exposure time corresponds to a lighter image but
is susceptible to blurring due to code movement. Exposure time is also

limited by the Internal Lighting mode parameter. Longer exposure times
can be set if the power strobe level is lowered.

High gain settings may produce a grainy image that may affect the decoding

process.

H} Calibration Tool

Top.Left

Image Acquisition Information

Acquisition Setting: 1
Exposure Time (x10us): 10
Gain: 400

Decoding Results

Symbology: Data Matix ECC 200
Code Data: Datalogic 2D Code Reader
Code Center: (X.Y)=(799,580)
Code Orientation: a

Image Lighting Quality

Exposure Index:
Underexposed 0K

Statistical information on the last 10 samples

Decode %:

Overexposed

@ Parameter Setup

o &

|

Internal Lighting Mode

Very High-Power Strobed

Stop Image Acquisition File Mode
(+ Disabled
" After Any Capture t I i I l manen | Interactive I
" OnNo Decode
fdnRecode 2D Codes l 1D Codes I Postal Codes ] Image Processing I Miscellaneous ]
Screen Mode Data Collection I Match Code ] Symbol Verification I Communication ]
&+ Decoded Image Reading System Layout I Ethernet ] Fieldbus I Display ] Diagnostics ]
¢ Code Position Only Operating Modes Calibration ] Digtall/0 |  LEDsAndKeypad |
fal =eeioe IMAGE ACQUISITION SETTING 1

Status Enabled

Self Tuning Disabled

Bottom Right 4' Exposure Time (x10us) 10

Self Tuning: Disabled s 400
Gain Increasing 1
Image Polarity Inversion Disabled
Region Of Interest: Top 10

Shkcdiok = Region Of Interest: Bottom 1209
Region Of Interest: Left 10

Quality Index: Region Of Interest: Right 1609
Image Filter Disabled

Lighting Index: Z

TXRX
_] Close

Figure 82 - Example Under Exposure: Too Dark
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Over-exposure:

To correct this result it is recommended to change the following parameters in their order of

appearance:

1. decrease the Gain
2. decrease the Exposure Time

Top Left Stop Image Acquisition
+ Disabled

" After Any Capture
" OnNo Decode

" OnDecode

Screen Mode

(¢ Decoded Image
(" Code Position Only
" Camera Mode

Bottom Right Q

Image Acquisition Information

Acquisition Setting: 1 Self Tuning: Disabled

Exposure Time (x10us): 50

Gain: 750

Decoding Results

Symbology: Data Matrix ECC 200 Selected Code: (il ﬁ

Code Data: Datalogic 2D Code Reader

Code Center: [X.Y)=(793,579)

Code Orientation: a Quality Index:

Image Lighting Quality

Exposure Index: Lighting Index: | 83% |
Underexposed oK Overexposed

Statistical information on the last 10 samples TXIRX

Close

H Parameter Setup

File Mode
I I yefaults l Perr | {Interactive
2D Codes I 1D Codes I Postal Codes ] Image Processing | Miscellaneous ]
Data Collection I Match Code ] Symbol Verification I Communication ]
Reading System Layout | Ethemnet ] Fieldbus l Display | Diagnostics ]
Dperating Modes Calibration ] Digtal /0 |  LEDséndKeypad |
IMAGE ACQUISITION SETTING 1
Status Enabled
Self Tuning Disabled
Intemal Lighting Mode Very High-Power Strobed
Exposure Time (x10us) 50
Gain 750
Gain Increasing #1
Image Polarity Inversion Disabled
Region Of Interest: Top 10
Redgion Of Interest: Bottom 1209
Region Of Interest: Left 10
Region Of Interest: Right 1609
Image Filter Disabled

Figure 83 - Example Over Exposure: Too Light
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Moving code out of the Field of View:

To correct this result and have the code completely visible in F.O.V., it is possible to follow
one or both the procedures listed below:

e reposition the reader
e use the Acquisition Trigger Delay by tuning the Delay Time (x100us)

& calibration Tool )55 | & parameter Setup =
Top.Left L - -
Stop Image Acquisition File Mode
(+ Disabled
¢ After Any Caplure | | ] | Cinteractive |
(" OnNoDecode
fd0nDecads 2D Codes ] 1D Codes I Postal Codes ] Image Processing ] Miscellaneous ]
Screen Mode Data Collection ] Match Code ] Symbol Verification ] Communication ]
¢ Decoded Image Reading System Layout |  Ethemet ] Fieldbus I Display | Diagnostics ]
----- OBIABAY - == -nc=mmmmcpessooscnomotonECen > G 3
sl ﬁ " Code Position Only Operating Modes Calibration I Digital 1/0 ] LEDs And Keypad ]
# Cnlit IMAGE ACQUISITION SETTING 1
Status Enabled
Self Tuning Disabled
Intemal Lighting Mode Very High-Power Strobed
Bottom,Right ; Ex=posure Time (x10us) 30
Image Acquisition Information -
Acquisition Setting: 1 Self Tuning: Disabled Gain 450
Exposure Time (x10us): 30 Gain Increasing %1
Gain: 450 Image Polarity Inversion Disabled
Decoding Results Region Of Interest: Top 10
Symbology: Data Matrix ECC 200 Selected Code: [ j’ Region Of Interest: Bottom 1209
Code Data: Datalogic 2D Code Reader Fegion Of1 L 10
Code Center: (X.Y)=(1496,679) egion OfIkerestiL eft
Code Orientation: 359 Quality Index: 0% Region Of Interest: Right 1603
Trage bighies GoaR Image Filter Disabled
Exposure Index: j_ Lighting Index: .29‘7°
Underexposed oK Overexposed
Statistical information on the last 10 samples TRIRX

Figure 84 - Example out of FOV

7.5.4 Multi Image Acquisition Settings

When controlled variable conditions occur in the application, Multiple Image Acquisition
Settings (up to 10), can be defined to create a database of parameter groups that handle
each specific application condition. This database of pre-defined settings functions cyclically
and therefore automatically improves system flexibility and readiness.

For example, an application may have two stable but different lighting conditions which
require different lighting options. One Image Acquisition Setting could enable and use the
internal illuminator and a second setting could enable and use an external lighting system.
These two groups will be used cyclically on each acquisition in order to automatically capture
the correctly lighted image.

One of the most useful cases for Multiple Image Acquisition Settings is to extend the reader's
depth of field (DOF). Some applications may require reading at more than one discrete
reading distance or an extended range of reading distances. See the methods described in
par. 7.5.5 and 7.5.6.

Image Acquisition Settings are found in the VisiSet™ Calibration parameter setup menu.
By selecting a different number and enabling its Status you can define the parameters for a
new group.
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7.5.5 Extending DOF Using Standard Acquisition Group (Cycle All In
Same Phase)

Multiple Image Acquisition Settings assigned to the same Acquisition Group (Standard), can
be configured and enabled to extend the reader's depth of field. During each reading phase,
decoding will be attempted by applying each enabled Image Acquisition Setting (cyclically).

Example:

Read a 15 mil Data Matrix ECC 200 code covering a range from 140 to 320 mm (see 15 mil
reading diagram). The reading distance range is too long to be covered by a single
acquisition setting, so two acquisition settings could be used in which the first has a Reading
Distance of 195 mm and the second has a Reading Distance of 300 mm. When both are
enabled, the reader cycles through the two settings effectively producing the extended DOF.

NOTE: Cycling through Image Acquisition Settings that require changing the
Reading Distance parameter (for liquid lens models), drastically reduces the
frame rate due to the liquid lens refocusing delay as well as by the number of
settings simultaneously enabled. Therefore this may not be the best solution
for high speed applications. For high speed applications it is best to use the
Alternative Acquisition Groups (Input Select) feature described in par. 7.5.6.
Otherwise use multiple readers set to different reading distances.

Since many factors and parameters contribute to maximizing the reading process, it is
suggested to use the VisiSet™ Standard Setup Wizard to set the different acquisitions
settings.

NOTE: By default the Alternative Acquisition Group Select parameter is
disabled.

Multi Image Acquisition Settings Procedure using Standard Setup Wizard:

1. Using the Standard Setup Wizard set the first acquisition setting (default) for the 195 mm
Reading Distance. Save the setting to Permanent Memory.
2. Through the Calibration Tool (Interactive Mode):
a. Set Calibration>Image Acquisition Setting 1 - Status to Disabled
b. Set Calibration>Image Acquisition Setting 2 - Status to Enabled
c. Set LEDs And Keypad>Autolearning Setup>Image Acquisition Setting to 2
d. Close the Calibration Tool
3. Using the Standard Setup Wizard set the second acquisition setting for the 300 mm
Reading Distance. Save the setting to Permanent Memory.
4. Through the Calibration Tool (Interactive Mode):
a. Set Calibration>Image Acquisition Setting 1 and 2 - Status to Enabled
b. Verify that the reader decodes at both distances then Close the Calibration Tool

c. Send Configuration to Permanent Memory

119



0 MATRIX 300™ REFERENCE MANUAL

7.5.6 Extending DOF Using Alternative Acquisition Group (Input Select)

NOTE: Do not use Interactive mode in VisiSet™ to set this feature.

Multiple Image Acquisition Settings assigned to different Acquisition Groups (Standard and
Alternative) can be configured and enabled to extend the reader's depth of field. The specific
Acquisition Group (Standard or Alternative) is selected prior to the reading phase so that only
the correct group setting will be applied to the entire reading phase.

When only two Image Acquisition Settings are used to extend DOF, (one in each group), this
effectively allows switching DOF while keeping the lens refocusing delay outside the reading
phase.

This feature is recommended for high speed applications.

NOTE: Within each group, if more than one Image Acquisition Setting is
enabled they will be cycled as in the case where Alternative Group Select is

disabled.

Example:

Read a 15 mil Data Matrix ECC 200 code covering a range from 140 to 320 mm (see 15 mil
reading diagram) at an application speed of 1 m/s. The reading distance range is too long to
be covered by a single acquisition setting, so two acquisition settings could be used in which
the first has a Reading Distance of 195 mm and is assigned to the Alternative Acquisition
Group, and the second has a Reading Distance of 300 mm and is assigned to the Standard
Acquisition Group.

By assigning the Alternative Group Select parameter to a proximity sensor (i.e. S32)
mounted at least 150 ms before the Acquisition Trigger and connected to an input (i.e.
Input 2), the correct DOF can be selected by enabling the correct group.

As an example, for a conveyor speed of 1 meter/second the Alternative Group Select
trigger must be placed at least 150 mm before the reading phase start (Ext. Trigger).

The proximity sensor must be calibrated to trigger on packs in the near zone (140-215 mm)
and therefore selects the Alternative Group with the Image Acquistion setting relative to the
195 mm Reading Distance. Packs farther away do not trigger the proximity sensor and so the
Standard Group is selected with the Image Acquistion setting relative to the 300 mm
Reading Distance.

The settings overlap in the range 210-220 mm and can be read by either one.

In this way the effective reading DOF covers the 140 -320 mm distance.
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g;»

40 Ext. Trigger

Proximity Sensor
on Input 2

Figure 85 - Example Extending DOF Using Alternative Acquisition Group

Since many factors and parameters contribute to maximizing the reading process, it is
suggested to use the VisiSet™ Standard Setup Wizard to set the different acquisitions
settings.

Multi Image Acquisition Settings Procedure using Standard Setup Wizard:

1. Using the Standard Setup Wizard set the first acquisition setting (default) for the 195 mm
Reading Distance. Save the setting to Permanent Memory.
2. Through the Calibration Tool (Interactive Mode):
a. Set Calibration>Image Acquisition Setting 1 - Status to Disabled
b. Set Calibration>Image Acquisition Setting 2 - Status to Enabled
c. Set LEDs And Keypad>Autolearning Setup>Image Acquisition Setting to 2
d. Close the Calibration Tool
3. Using the Standard Setup Wizard set the second acquisition setting for the 300 mm
Reading Distance. Save the setting to Permanent Memory.
4. Get the Configuration from the Device Memory (do not use Interactive mode):
. Set Operating Mode>Alternative Acquisition Group Select to Input 2 Leading Edge

. Set Calibration>Image Acquisition Setting 1 > Status to Enabled

. Set Calibration>Image Acquisition Setting 2 > Status to Enabled

a
b
c. Set Calibration>Image Acquisition Setting 1 > Acquisition Group to Alternative
d
e. Set Calibration>Image Acquisition Setting 2 > Acquisition Group to Standard
f.

Send Configuration to Permanent Memory

5. Verify that the reader decodes at both distances with the Calibration Tool.
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7.5.7 Run Time Self Tuning (RTST)

Run Time Self-Tuning (RTST) increases Matrix’s flexibility in the presence of uncontrolled
variable conditions (lighting, code contrast, etc.) by automatically adjusting its acquisition
parameters.

Self Tuning Calibration

In the Calibration parameter setup menu, the Self Tuning parameters manage the Image
Acquisition Setting parameters dynamically. Self Tuning provides automatic adjustment in
run time of different acquisition parameters (Exposure Time and/or Gain) for each captured
image based on calculations performed on previous acquisitions. These dynamic settings will
be used instead of the static settings saved in memory.

From to
Not Readable Readable

For more details see the Matrix 300™ Help On-Line.

Self Tuning Image Processing

In the Image Processing parameter setup menu, the Self Tuning parameters manage the
Image Processing and Symbology related parameters. They perform different processing
attempts on the same captured image according to the selected Self Tuning Mode parameter
value: (Symbologies Only, Processing Modes Only, Decoding Methods Only, Code Contrast
Levels Only, Image Mirroring Only, or General Purpose).

For more details see the Matrix 300™ Help On-Line.
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7.5.8 Region Of Interest Windowing

In order to satisfy very high throughput applications, higher frame rates can be achieved
using the powerful Region Of Interest Windowing parameters in the Calibration parameter
setup menu.

Region Of Interest Windowing allows defining a region or window within the reader FOV.
The Top, Bottom, Left and Right parameters allow to precisely define the image window to
be processed, visualized and saved.

In all Matrix 300™ models the frame rate is dependent on the number of lines (or rows) in the
defined window.

The smaller the window, the lower the frame period and consequently the higher the frame
rate. In general the Image Processing time can be reduced by reducing the window
dimensions.

E Calibration Tool

EE Parameter Setup

ooLet Stop Image Acquisition File Mode
| (+ Disabled
" After Any Capture et | i ’ ult l maner | Interactive l
¢ OnNoDecode
0.1 = - — —
| OnDecods Data Collection l Match Code ] Symbol Verification I Communication |
° i ° Screen Mode Reading System Layout I Ethermet I Fieldbus ] Display I Diagnostics I
| | (+ Decoded Image 2D Codes I 1D Codes | Postal Codes | Image Processing ] Miscellaneous |
I | | | "~ Code Position Only Operating Modes Calibration I Digital [0 ] LEDs And Keypad |
* 020imm ¢ Camera Mode IMAGE ACQUISITION SETTING 1
Status Enabled
° °
m mm m Self Tuning Disabled
Intemal Lighting Mode Very High-Power Strobed
Bottom,Right 4‘ Exposure Time (x10us) 30
Image Acquisition Information 3
Acquisition Setting: 1 Self Tuning: Disabled Gain 450
Exposure Time (x10usk 30 Gain Increasing %1
Gain: 450 Image Polarity Inversion Disabled
Decoding Results Region Of Interest: Top 300
: 5 = 5
Symbology: Code 128 Selected Code: 1 = Region OF Interest: Bottom 900
Code Data: 0.20 mm Fegion OF 1 e 200
Code Center: (X.Y)=(793,600) egion Oflnierest el
Eode Brentation: 0 Region Of Interest: Right
Image Lighting Quality mage Filter
Exposure Index: Lighting Index:
Underexposed oK Overexposed
Statistical information on the last 10 samples TX/RX

dots delimiting the calibration algorithm area may be located outside the

@ NOTE: If using Region Of Interest windowing, some or all of the four red
VisiSet™ display area (not visible).
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7.5.9 Direct Part Marking Applications

Decoding Method: Direct Marking

For Data Matrix codes the Decoding Method parameter selects the decoding algorithm
according to the printing/marking technique used to create the symbol and on the overall
printing/marking quality. The Direct Marking selection improves the decode rate for low
quality Direct Part Mark codes and in general for Direct Part Mark codes with dot peening

type module shapes.

Washed out and Axial
Distortion

Background
Problems

A &
Half moon effects

Dot Peening On
Scratched Surface

Marked On Curved
Shiny Surface

Shiny surface,
noisy background

Low Contrast
Problem

Axial
distortion

ol
AR g
S RS

Low contrast,
noisy background

R
S
3
%

All the previous examples are successfully read selecting the Direct Marking Decoding
Method.
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Image Filter

Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (ex. Direct part mark codes).

A different filter can be applied to each Image Acquisition Setting.

The Erode Filter enlarges the image dark zones to increase readability.

Before - No Read After - Readable

Erode

The Dilate Filter enlarges the image white zones to increase readability.

Before - No Read After - Readable

Dilate

The Close filter eliminates dark areas (defects) in the white zones of the image.

After - Readable

Before - No Read

Close
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The Open filter eliminates white areas (defects) in the dark zones of the image.

Before - No Read After - Readable
Open

The Contrast Stretching filter maximizes image contrast.

Before - No Read After - Readable
Contrast Stretching
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The Histogram Equalization filter makes the gray level distribution uniform.

Before - No Read After - Readable
Histogram Equalization

The Smoothing filter deletes small (insignificant) details in the center of the image.

Before - No Read After - Readable
Smoothing

The Sharpening filter improves out of focus images.

Before - No Read After - Readable
Sharpening

127



o MATRIX 300™ REFERENCE MANUAL

The Deblurring filter improves blurred images.

Before - No Read After - Readable
Deblurring

The Black Enhancement filter produces a nonlinear increase in the black level for light
images.

Before - No Read After - Readable
Black Enhancement

The White Enhancement filter produces a nonlinear increase in the white level for dark
images.

Before - No Read After - Readable
White Enhancement
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7.6 IMAGE CAPTURE AND DECODING

By using the Capture Image and Decode Last Image functions from the VisiSet™ Main
menu, you can get information about the image decodable codes in terms of Symbology,
encoded Data, Position and Orientation, Decode Time and Code Quality Assessment Metrics.

File Edit Connect Disconnect Devic

MAIN MENU

. Vi 13

Connection: CO8I00820 on 172.16.11.12

e Options Tools Help

Image captured (1600x1200) using Acquisition Setting #1 (Self

Tuning disabled).
KKK KRKAKKRARKHK Tmage Processing started (#1):

Hew Code (#1.1):

Symbology: Data Matrix ECC 200

Humber of Characters: 24

Code Center Position: (805,604)

Pixel per Element: 10.6

Module Size: 24.0 mils @ Focus Distance
Decoding Time (ms): 322

Code Orientation: 0°

Code Bounds: TL[679,485] TR[930,485]
Symbol Size: 20x20

Print Growth: 7%

Code Quality Index: 100%

ISO-IEC 15415 Quality Indicators:

: A 4.0/18/660 (4)

BL[679,723]

Overall Grade

Decode

Symbhol Contrast A

Axial Hon Uniformity A

Unused Error Correction: A

Modulation : A

Fixed Pattern Damage A

Grid Non Uniformity : A
Data: Datalogic 2D Code Reader

Image Exposure Quality: 80%
Image Processing Time (ms): 323

Khkkkkkkhkkhkkhkkhkk* Tmage Processing completed (#1).

Reader Status: OFF LINE MODE Log : OFF

BR[932,723]

EBX

Figure 86 - Capture and Decoding Functions

7.7 STATISTICS

Statistics on the reading performance can be viewed by enabling the Statistics parameter
and selecting the View Statistics item in the File menu. One of three different windows
appears depending on the operating mode.

Refer to the VisiSet™ Help On Line for more details.

Total Samples

Last Decoded Code
Symbology:
Code Data:

Acquisition Counter: 1000
Complete Read Counter: 1000
Complete Reads [%): 100.00
Last Samples

Acquisition Counter: 20
Complete Read Counter: 20
Complete Reads (%): 100.00
Reading Performance

Mean Decoding Time [ms): 22
Max Decoding Time (ms): 22
Frame Rate (Images/s): 14

Data Matrix ECC 200
Datalogic 2D Code Reader

Reset

Figure 87 - Code Statistics
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8 MAINTENANCE

8.1 CLEANING

Clean the reading window (see Figure A, 1) periodically for continued correct operation of the
reader.

Dust, dirt, etc. on the window may alter the reading performance.
Repeat the operation frequently in particularly dirty environments.

Use soft material and alcohol to clean the window and avoid any abrasive substances.
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9 TROUBLESHOOTING

9.1 GENERAL GUIDELINES

e When wiring the device, pay careful attention to the signal name (acronym) on the
CBX100/500 spring clamp connectors (chp. 4). If you are connecting directly to the Matrix
300™ M16 19-pin connector pay attention to the pin number of the signals (chp. Errore.
L'origine riferimento non é stata trovata.).

o If you need information about a certain reader parameter you can refer to the VisiSet™
program help files. Either connect the device and select the parameter you’re interested in
by pressing the F1 key, or select Help>Paramters Help from the command menu.

o If you're unable to fix the problem and you’re going to contact your local Datalogic office or
Datalogic Partner or ARC, we suggest providing (if possible): Application Program version,
Parameter Configuration file, Serial Number and Order Number of your reader. You can
get this information while VisiSet™ is connected to the reader: the Application Program
version is shown in the Terminal Window; the Parameter Configuration can be saved to an
ini file applying the File>Save Configuration File command in the Parameter Setup
window; Serial Number and Order Number can be obtained by applying the respective
command in the Tools menu.

TROUBLESHOOTING GUIDE

Problem Suggestion

Power ON: e Is power connected?

the “POWER” LED is not lit. o If using a power adapter (like PG6000), is it connected
to wall outlet?

e If using rail power, does rail have power?

o If using CBX, does it have power (check switch and
LED)?

e Check if you are referring to the M16 19-pin connector
or to the CBX spring clamp connectors.

e Measure Voltage either at pin A and pin L (for 19-pin
connector) or at spring clamp Vdc and GND (for CBX).

One Shot or Phase Mode | Check if you are referring to the 19-pin connector or to

using the Input 1 (External the CBX spring clamp connectors.

Trigger) or Input 2: e Is the sensor connected to the Input 1 or Input 2?

the "TRIGGER” LED is not |e Is power supplied to the photo sensor?

blinking while the External |[e¢ For NPN configuration, is power supplied to one of the

Trigger is switching. two 11 or 12 signals (A or B)?

o For PNP configuration, is one of the two I1 or 12 signals
grounded (A or B)?

o Are the photo sensor LEDS (if any) working correctly?

e Is the sensor/reflector system aligned (if present)?

e In the Digital 1/O folder check the EXTERNAL
TRIGGER or INPUT 2\Debounce Filter parameter
setting.

e In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

One Shot or Phase Mode
using serial trigger source:
the "TRIGGER” LED is not
blinking.

In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.

Are the COM port parameters (Baud Rate, Parity, Data
Bits, Stop Bits, Handshake) correctly assigned?

In the communication folder, check the settings of
Reading Phase-ON String, Acquisition Trigger
String and Reading Phase-OFF String parameters.

Is the serial trigger source correctly connected?

Phase Mode:

the "TRIGGER" LED is
correctly blinking but no image
is displayed in VisiSet™
Calibration Tool window.

Is the Phase frequency lower than the maximum frame
rate?

Continuous Mode:

Verify the correct software configuration settings.

correctly blinking but no result
is transmitted by the reader at
the end of the reading phase
collection.

the "TRIGGER” LED is not

blinking.

Any Operating Mode: ¢ In the Data Collection folder check the settings for the
the "TRIGGER” LED is CODE COLLECTION, DATA FORMAT and

STATISTICS parameter groups.

Image not clear:

verify the Focus procedure

the reader always transmits
the No Read Message

Image focused but not |e verify the Calibrate Image Density prodcedure.
decoded:
Reading: e Run the Rapid Configuration procedure in chapter 1.

Position the reader as described in par. 3.3 and through

the VisiSet™ Calibration Tool:

— Tune the ACQUISITION TRIGGER DELAY, if the
moving code is out of the reader field of view;

— Set the Continuous Operating Mode if no external
trigger source is available;

— Tune the IMAGE ACQUISITION SETTING to
improve the code image quality;
— Check the parameter setting in Decoding,

2D Codes, 1D Codes, and Postal Codes folders;
— View the full resolution code image to check the
printing or marking quality.

Communication:
reader is not transmitting
anything to the host.

Is the serial cable wiring correct?

If using CBX, be sure the RS485/422 termination switch
is OFF.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Digital I/O folder, "COM" LED can be
configured to indicate MAIN COM port TX or MAIN
COM port RX.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

Communication:

data transferred to the host
are incorrect, corrupted or
incomplete.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Communication folder check the settings of
Header and Terminator String parameters.

In VisiSet™ Data Collection folder, check the settings of
DATA FORMAT parameter group.

How do | obtain my reader
Serial Number?

The reader Serial Number consists of 9 characters: one
letter, 2 numbers, another letter followed by 5 numbers.
The reader Serial Number is printed on a label that is
affixed on the bottom case near the reading window.
The Serial Number can also be obtained by selecting
Tools/Get Reader Serial Number from the command
menu in VisiSet™. A dedicated window will appear.

How do | obtain my reader
Order Number?

The reader Order Number consists of 9 numbers.

The reader Order Number can be obtained by selecting
the Tools/Get Reader Order Number from the command
menu in VisiSet™. A dedicated window will appear.
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10 TECHNICAL FEATURES

ELECTRICAL FEATURES

- RS485/422 full-duplex

Power 4xx-01x models 4xx-04x models
Supply Voltage 10 to 30 Vdc PoE Device 48 Vdc
Consumption 0.7t0 0.2 A 13 W max.
Communication Interfaces

Main

- RS232 2400 to 115200 bit/s

2400 to 115200 bit/s

Auxiliary - RS232

2400 to 115200 bit/s

ID-NET™ Up to 1Mbaud
Ethernet 10/100 Mbit/s
(supports application protocols: TCP/IP, EtherNet/IP, Profinet |10, Modbus TCP)
Inputs
Input 1(External Trigger) and Input 2 Opto-coupled and polarity insensitive; see note for POE models
Max. Voltage 30 Vdc
Max. Input Current 10 mA
Outputs *
Output 1,2 and 3 NPN or PNP short circuit protected; see note for POE models
Vout (lload = 0 mA) Max. 30 Vdc
Vout (lload = 100 mA) Max. 3 Vdc
lload Max 100 mA

OPTICAL FEATURES

Image Sensor

CMOS sensor with Global Shutter

Image Format

SXGA (1280x1024) pixels

Focal Length
Focus Control

Frame Rate 60 frames/sec.
Pitch + 35°

Tilt 0° - 360°
LED Safety to EN 62471
Laser Safety (pointers) IEC60825-1 2007
Lens 4x1-0xx models

4x2-0xx models
9 mm
via software

6 mm
via adjusting screw

Lighting System

Internal llluminator

Aiming System

Laser Pointers

ENVIRONMENTAL FEATURES

Operating Temperature

0 to 50 °C (32 t0 122 °F) **

Storage Temperature

-20 to 70 °C (-4 to 158 °F)

EN 60068-2-27

Max. Humidity 90% non condensing

Vibration Resistance 14 mm @ 2to 10 Hz; 1.5 mm @ 13 to 55 Hz;
EN 60068-2-6 29 @ 70 to 200 Hz; 2 hours on each axis
Bump Resistance 309; 6 ms;

EN 60068-2-29 5000 shocks on each axis

Shock Resistance 30g; 11 ms;

3 shocks on each axis

Protection Class

IP65/IP67 ***

EN 60529

PHYSICAL FEATURES Connector position 0° Connector position 90°
Dimensions 95x54 x43 mm (3.7 x2.1x1.7in.) | 75x54x62 mm (3.0x2.1x2.41in.)
Weight about 238 g. (8.4 0z.)

Material Aluminium

* when connected to the CBX connection boxes the electrical features for Output 1 and 2 become the following:
Vce = 30 Vdc max.; Ice = 40 mA continuous max.; 130 mA pulsed max.; Vce saturation = 1 Vdc max. @ 10 mA;
Pp =90 mW Max. @ 50 °C ambient temp.

** high ambient temperature applications

should use metal mounting bracket for heat dissipation

*** when correctly connected to IP67 cables with seals.
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SOFTWARE FEATURES

Readable Code Symbologies

1-D and stacked

e PDF417 Standard and Micro PDF417
Code 128 (GS1-128)

Code 39 (Standard and Full ASCII)
Code 32

MSI

e Standard 2 of 5

e Matrix 2 of 5

o Interleaved 2 of 5

e Codabar

e Code 93

¢ Pharmacode

e EAN-8/13 - UPC-A/E
(including Addon 2 and Addon 5)

e GS1 DataBar Family
e Composite Symbologies

2-D POSTAL
e Data Matrix ECC 200 o Australia Post
(Standard, GS1 and Direct Marking) | e Royal Mail 4 State Customer
¢ QR Code o Kix Code
(Standard and Direct Marking) e Japan Post
e Micro QR Code e PLANET
* MAXICODE e POSTNET
e Aztec Code e POSTNET (+BB)
o Intelligent Mail
o Swedish Post

Operating Mode

ONE SHoT, CONTINUOUS, PHASE MODE

Configuration Methods

X-PRESS™ Human Machine Interface
Windows-based SW (VisiSet™) via serial or Ethernet link
Serial Host Mode Programming sequences

Parameter Storage

Permanent memory (Flash)

CODE QUALITY METRICS

Standard

Supported Symbologies

ISO/IEC 16022
ISO/IEC 18004
ISO/IEC 15415
ISO/IEC 15416

AS9132A
AIM DPM

Data Matrix ECC 200
QR Code
Data Matrix ECC 200, QR Code

Code 128, Code 39, Interleaved 2 of 5, Codabar, Code 93, EAN-8/13,
UPC-A/E

Data Matrix ECC 200
Data Matrix ECC 200, QR Code

USER INTERFACE

LED Indicators

Power, Ready, Good; Trigger; Com, Status, (Ethernet Network); Good
Read (Green Spot), No Read (Red Spot)

Keypad Button

Configurable via VisiSet™

Beeper

Configurable via VisiSet™
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A ALTERNATIVE CONNECTIONS

The connector pinouts and notes given in this appendix are for custom cabling applications.

POWER, COM AND I/O CONNECTOR

The Matrix 300™ reader is equipped with an M12 17-pin male connector for connection to
the power supply, serial interfaces and input/output signals. The details of the connector pins
are indicated in the following table:

12 2 3 13
1" 4

5
10 14
16 6

7 17
815

Figure 88 —M12 17-pin male COM, I/O and Power Connector

Power, COM and I/O Connector Pinout
Pin Name Function
1 Vdc Power supply input voltage +
2 GND Power supply input voltage -
Connector CHASSIS Conne_:ctor case provides electrical connection to the
case chassis
6 I11A External Trigger A (polarity insensitive)
5 11B External Trigger B (polarity insensitive)
13 12A Input 2 A (polarity insensitive)
3 12B Input 2 B (polarity insensitive)
9 01 Output 1 (NPN or PNP short circuit protected
8 02 Output 2 and software programmable)
16 03 Output 3 prog
14 RX Auxiliary RS232 RX
4 TX Auxiliary RS232 TX
7 ID+ ID-NET™ network +
15 ID- ID-NET™ network -
Pin Name RS232 RS485/422 Full-Duplex
17 MAIN TX TX+
11 INTERFACE RX *RX+
12 (SW RTS TX-
10 SELECTABLE) CTS *RX-

* Do not leave floating, see par. 4.2.2 for connection details.

In order to meet EMC requirements:

e connect the reader chassis to the plant earth ground by means of a flat copper braid
shorter than 100 mm;

e connect your cable shield to the locking ring nut of the connector.
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ON-BOARD ETHERNET CONNECTOR

A Standard M12 D-Coded female connector is provided for the on-board Ethernet
connection. This interface is IEEE 802.3 10 BaseT and IEEE 802.3u 100 BaseTx compliant.

Figure 89 - M12 D-Coded Female Ethernet Network Connector

On-Board Ethernet Network Connector Pinout
Pin Name Function
1 X + Transmitted data (+)
2 RX + Received data (+)
3 TX - Transmitted data (-)
4 RX - Received data (-)

Power over Ethernet (POE) Models

Figure 90 - M12 D-Coded Female Ethernet Network Connector

Power over Ethernet Network Connector Pinout
Pin Name Function
1 TX +/DC- Transmitted data (+) DC power (-)
2 RX +/DC+ Received data (+) DC power (+)
3 TX -/DC- Transmitted data (-) DC power (-)
4 RX -/DC+ Received data (-) DC power (+)

over RJ45 pins 1, 2, 3, 6), Class 0 power levels. Use an Endspan or
Midspan PSE device that supports this configuration (i.e. POE switch or
Power over Ethernet Adapter).

Alternative B (power over RJ45 pins 4, 5, 7, 8) using an Endspan or
Midspan PSE device is not supported.

f CAUTION: Matrix 300™ PoE models only accept Alternative A (power
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PSE Endspan Matrix 300
RJ45 Ethernet Connector M12 Ethernet Connector

Data Pair 3 E Data Pair

Positive +

48 Vdc
|§ Data Pair

Negative -
Figure 91 — Matrix 300™ PoE PSE Endspan Alternative A Connections OK

Data Pair g

Non PoE Ethernet Switch PSE Midspan Matrix 300
RJ45 Ethernet Connector RJ45 Ethernet Connectors M12 Ethernet Connector
Data Pair E Data Pair
Eosilve CAB-ETH-MOx
48 Vdc (RJ45 to M12) 4-pin
Negative -
Data Pair ‘E Data Pair

Figure 92 — Matrix 300™ PoE PSE Midspan Alternative A Connections OK

Matrix 300
M12 Ethernet Connector

PSE Endspan
RJ45 Ethernet Connector

Data Pair §|

Positive +
48 Vdc
Negative -

@
Data Pair §I| ’g Data Pair
@

E Data Pair

Figure 93 — Matrix 300™ PoE PSE Endspan Alternative B Connections NOT SUPPORTED
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Non PoE Ethernet Switch
RJ45 Ethernet Connector

Data Pair

Data Pair

PSE Midspan
RJ45 Ethernet Connectors

CAB-ETH-MOx
(RJ45 to M12) 4-pin

Matrix 300

M12 Ethernet Connector

Figure 94 — Matrix 300™ PoE PSE Midspan Alternative B Connections NOT SUPPORTED

CAUTION: For Matrix 300™ PoE models, the internal Digital Output
circuitry is not powered and supply power is not available to any Input/Output
devices (Vdc=0). Only input device signals can be accepted directly on the
M12 17-pin connector without power.
For these models, if it is necessary to use Input/Output devices, we recommend
connecting them through the CBX, which must be powered separately.

ID-NET™ NETWORK TERMINATION

The network must be properly terminated by a 120 Ohm resistor at the first and last reader of

the network.

INPUTS

There are two optocoupled polarity insensitive inputs available on the M12 17-pin connector
of the reader: Input 1 (External Trigger) and Input 2, a generic input. See par. 4.5 for more

details.

The electrical features of both inputs are:

INPUT | Vv ABl Min. | V ABl Max. I v Max
Open ov 2V 0 mA
Closed 45V 30V 10 mA

The relative pins on the M12 17-pin connector are:

Pin |Name Function
1 Vdc Power Supply input voltage +
6 1A External Trigger A (polarity insensitive)
5 11B External Trigger B (polarity insensitive)
13 |I2A Input 2 A (polarity insensitive)
3 12B Input 2 B (polarity insensitive)
2 GND Power Supply input voltage -
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OUTPUTS

Three general purpose non opto-isolated but short circuit protected outputs are available on
the M12 17-pin connector. See par. 4.6 for more details.

The pinout is the following:

Pin |Name Function
9 01 Configurable digital output 1
8 02 Configurable digital output 2
16 |03 Configurable digital output 3
2 GND Ouptut reference signal

The electrical features of the three outputs are the following:

Reverse-Polarity and Short-Circuit Protected
Vout (ILOAD =0 mA) max = 30 Vdc
VOUT (ILOAD =100 mA) max = 3 Vdc

lLoap Max

=100 mA

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.

Matrix 300™ USER INTERFACE

V_d_c

— éz‘ BECEE
— i
E ==

T —

Figure 95 - PNP Output Connection

Matrix 300™ USER INTERFACE
Vdc Vext
i 9/8/16
- i
—'% i 2
T - L J_

Figure 96 - NPN Output Connection
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must not exceed the Matrix 300™ power supply source voltage (Vdc)

f CAUTION: For NPN output connections, the external interface voltage (Vext)
otherwise correct output functioning cannot be guaranteed.

Matrix 300™ USER INTERFACE
Vdc

9/8/16

Ha—r‘ Tl

L
h

»l

_|

= RPN R —

Figure 97 - Push-Pull Output Connection

CAUTION: For Matrix 300™ PoE models, the internal Digital Output

& circuitry is not powered and supply power is not available to any Input/Output
devices (Vdc=0). Only input device signals can be accepted directly on the
M12 17-pin connector without power.

For these models, if it is necessary to use Input/Output devices, we recommend
connecting them through the CBX, which must be powered separately.
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USER INTERFACE - SERIAL HOST

RS232 PC-side connections

9-pin male connector

1

13

\o.o.o.o.o.o.o.o.o.o.o.o.o/

14

25-pin male connector

25

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS

How To Build A Simple Interface Test Cable:

The following wiring diagram shows a simple test cable including power, external (push-
button) trigger and PC RS232 COM port connections.

M12 17-pin female

9-pin D-sub female

Trigger I—l:

17 TX /A N\ 2 Ly
11_RX \\ 3 JLx » PC
/5 GND
2 4
2 GND
Matrix 300™ < j 1 vde
6 I11A
j 5 11B ]
Power Supply
Power GND

VS (10 — 30 VDC)

Figure 98- Test Cable for Matrix 300™
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GLOSSARY

AlM
(Association for Automatic Identification and Mobility): AIM Global is the international trade
association representing automatic identification and mobility technology solution providers.

AIM DPM Quality Guideline

Standard applicable to the symbol quality assessment of direct part marking (DPM)
performed in using two-dimensional bar code symbols. It defines modifications to the
measurement and grading of several symbol quality parameters.

AS9132
Standard defining uniform quality and technical requirements for direct part marking (DPM)
using Data Matrix symbologies.

Barcodes (1D Codes)

A pattern of variable-width bars and spaces which represents numeric or alphanumeric data
in machine-readable form. The general format of a barcode symbol consists of a leading
margin, start character, data or message character, check character (if any), stop character,
and trailing margin. Within this framework, each recognizable symbology uses its own unique
format.

BIOS
Basic Input Output System. A collection of ROM-based code with a standard API used to
interface with standard PC hardware.

Bit

Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits
compose one byte of data. The pattern of 0 and 1 values within the byte determines its
meaning.

Bits per Second (bps)
Number of bits transmitted or received per second.

Bright Field Illlumination

Lighting of surfaces at high (narrow) angles used to provide maximum reflection of the light
to the reader’s lens. This is effective on surfaces that absorb light or are not highly reflective
and also on low contrast codes.

Byte

On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to
represent a specific character or numeric value. Bits are numbered from the right, O through
7, with bit O the low-order bit. One byte in memory can be used to store one ASCII character.

Composite Symbologies
Consist of a linear component, which encodes the item's primary data, and an adjacent 2D
composite component, which encodes supplementary data to the linear component.

Dark Field lllumination

Lighting of surfaces at wide angles used to avoid direct reflection of the light into the reader’s
lens. Typically this type of lighting is used in DPM solutions to enhance reflectance of the
uneven surface do to the symbol marking technique. It is also used with very reflective
surfaces.
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Decode
To recognize a barcode symbology (e.g., Codabar, Code 128, Code 3 of 9, UPC/EAN, etc.)
and analyze the content of the barcode scanned.

Depth of Field
The difference between the minimum and the maximum distance of the object in the field of
view that appears to be in focus.

Diffused Illlumination
Distributed soft lighting from a wide variety of angles used to eliminate shadows and direct
reflection effects from highly reflective surfaces.

Direct Part Mark (DPM)
A symbol marked on an object using specific techniques like dot peening, laser etching,
chemical etching, etc.

EEPROM
Electrically Erasable Programmable Read-Only Memory. An on-board non-volatile memory
chip.

Element
The basic unit of data encoding in a 1D or 2D symbol. A single bar, space, cell, dot.

Exposure Time
For digital cameras based on image sensors equipped with an electronic shutter, it defines
the time during which the image will be exposed to the sensor to be acquired.

Flash
Non-volatile memory for storing application and configuration files.

Host

A computer that serves other terminals in a network, providing services such as network
control, database access, special programs, supervisory programs, or programming
languages.

Image Processing
Any form of information processing for which the input is an image and the output is for
instance a set of features of the image.

Image Resolution
The number of rows and columns of pixels in an image. The total number of pixels of an
image sensor.

Image Sensor
Device converting a visual image to an electric signal. It is usually an array of CCD (Charge
Coupled Devices) or CMOS (Complementary Metal Oxide Semiconductor) pixel sensors.

IEC
(International Electrotechnical Commission): Global organization that publishes international
standards for electrical, electronic, and other technologies.
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IP Address

The terminal’s network address. Networks use IP addresses to determine where to send
data that is being transmitted over a network. An IP address is a 32-bit number referred to as
a series of 8-bit numbers in decimal dot notation (e.g., 130.24.34.03). The highest 8-bit
number you can use is 254.

ISO
(International Organization for Standardization): A network of the national standards
institutes of several countries producing world-wide industrial and commercial standards.

LED (Light Emitting Diode)
A low power electronic light source commonly used as an indicator light. It uses less power
than an incandescent light bulb but more than a Liquid Crystal Display (LCD).

LED Illuminator
LED technology used as an extended lighting source in which extra optics added to the chip
allow it to emit a complex radiated light pattern.

Matrix Symbologies (2D Codes)

An arrangement of regular polygon shaped cells where the center-to-center distance of
adjacent elements is uniform. Matrix symbols may include recognition patterns which do not
follow the same rules as the other elements within the symbol.

Multi-row (or Stacked) Symbologies
Symbologies where a long symbol is broken into sections and stacked one upon another
similar to sentences in a paragraph.

RAM
Random Access Memory. Data in RAM can be accessed in random order, and quickly
written and read.

Symbol Verification
The act of processing a code to determine whether or not it meets specific requirements.

Transmission Control Protocol/Internet Protocol (TCP/IP)

A suite of standard network protocols that were originally used in UNIX environments but are
now used in many others. The TCP governs sequenced data; the IP governs packet
forwarding. TCP/IP is the primary protocol that defines the Internet.
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